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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

 
WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to 
personal injury or death, property damage, or economic loss. 

 

 
ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

 
IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

 
SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

 

 
BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 
temperatures. 

 

 
ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash 
will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and 
for Personal Protective Equipment (PPE). 
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Preface 

The Getting Results Guide provides you with information on installing and 
using FactoryTalk® Linx Gateway. 

Tip: The Getting Results Guide is included in a portable document format (PDF) 
on your FactoryTalk Linx Gateway software installation DVD. These files 
must be viewed using the Adobe® Acrobat® Reader software. 

This section includes the following information: 

• Intended audience 
• Where to find additional information 
• Legal notices 

You should be familiar with: 

• Microsoft® Windows® operating systems 
• FactoryTalk Linx (previously called RSLinx Enterprise) 
• Allen-Bradley® programmable logic controllers (PLCs) and 

programmable automation controllers (PACs) 
• Rockwell Automation control system development software 

For additional information about FactoryTalk Linx Gateway, consult the 
following resources: 

 

The Help includes overview, procedural, screen, and reference information 
for the product. The Help contains these basic components: 

• Overview topics 
• Quick-start topics 
• Step-by-step procedures 
• Dialog box descriptions 

To view the Help, click Help in the FactoryTalk Linx Gateway Configuration 
Tool. 

The Release Notes provide information updates that are necessary to use 
FactoryTalk Linx Gateway effectively. The Release Notes contains the 
following components: 

• System requirements 
• System features 
• Anomalies 
• Functional changes 
• Application notes 

To view the FactoryTalk Linx Gateway Release Notes, download them from the 
Product Compatibility and Download Center 
http://www.rockwellautomation.com/compatibility/#/scenarios. 

The Rockwell Automation Customer Support Center offers an extensive 
online database that includes frequently asked questions and the latest 

About this publication 

Intended audience 

Find additional information 

Help 

Release Notes 

Knowledgebase 

http://www.rockwellautomation.com/compatibility/#/scenarios
http://www.rockwellautomation.com/compatibility/#/scenarios


Preface  
 

8 Rockwell Automation Publication FTLG-GR001C-EN-E - September 2020  
 

patches. The Knowledgebase web page leads to a comprehensive, searchable 
database of support information for all Rockwell Automation products.  

To access the Knowledgebase web page, visit 
http://www.rockwellautomation.com/support, then select Knowledgebase 
Support Center. 

Questions concerning installation and use of FactoryTalk Linx Gateway 
software are handled by the Rockwell Automation Customer Support Center. 
The center is staffed Monday through Friday, except on U.S. holidays, from 8 
a.m. to 5 p.m. Eastern time zone for calls originating within the U.S. and 
Canada. 

To reach the Customer Support Center, call 440-646-3434 and follow the 
prompts. For calls originating outside the U.S. or Canada, locate the number 
in your country by visiting 
https://rockwellautomation.custhelp.com/app/phone. 

When you call, you should be at your computer and be prepared to provide the 
following information: 

• The product version number 
• The type of hardware you are using 
• The exact wording of any errors or messages that appeared on your 

screen 
• A description of what happened and what you were doing when the 

problem occurred 
• A description of how you tried to solve the problem 

 

Rockwell Automation offers a wide range of training programs, from 
regularly scheduled classes to custom-tailored classes conducted at your site. 

If you need more information about these training programs, visit the 
Rockwell Automation site or contact the Rockwell Automation Training 
Coordinator. The web site address and telephone numbers are available at the 
bottom of the back cover. 

Rockwell Automation provides expert consulting and turnkey 
implementations for making optimal use of Rockwell Automation software 
products. Please contact your local representative for more information. 

Rockwell Automation publishes legal notices, such as privacy policies, license 
agreements, trademark disclosures, and other terms and conditions on the 
Legal Notices page of the Rockwell Automation website. 

Technical support 

Training programs 

Consulting services 

Legal Notices 

http://www.rockwellautomation.com/support
https://rockwellautomation.custhelp.com/app/phone
https://www.rockwellautomation.com/global/legal-notices/overview.page
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End User License Agreement (EULA) 

You can view the Rockwell Automation End User License Agreement (EULA) 
by opening the license.rtf file located in your product's install folder on your 
hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf. 

Open Source Software Licenses 

The software included in this product contains copyrighted software that is 
licensed under one or more open source licenses.  

You can view a full list of all open source software used in this product and 
their corresponding licenses by opening the index.html file located your 
product's OPENSOURCE folder on your hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\FactoryTalk Linx 
Gateway\Release Notes\OPENSOURCE\index.htm 

You may obtain Corresponding Source code for open source packages 
included in this product from their respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: http://www.rockwellautomation.com/global/about-
us/contact/contact.page. Please include "Open Source" as part of the request 
text. 

 

 

http://www.rockwellautomation.com/global/about-us/contact/contact.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
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Chapter 1 

Welcome to FactoryTalk Linx Gateway 

This chapter includes the following information: 

• What is FactoryTalk Linx Gateway? 
• Overview of basic concepts 
• Quick start: Set up and use FactoryTalk Linx Gateway 

FactoryTalk® Linx™ Gateway is an OPC Unified Architecture (UA) and Classic 
Data Access (DA) data server. It allows OPC clients to connect to and access 
tag data from FactoryTalk applications that contain FactoryTalk Linx and 
FactoryTalk View SE servers. FactoryTalk Linx Gateway can send data to, and 
retrieve data from, any FactoryTalk Live Data server or OPC server that is 
defined within a FactoryTalk system. 

FactoryTalk Linx Gateway consists of: 

• A service that provides tag data to OPC DA clients. 
• A service that provides tag data to OPC UA clients. 
• A configuration tool that configures the runtime operation of the 

service. The configuration tool enables the selection of the area or 
application, from which you want to access data (called the scope) as 
well as to start and stop the service. 

Use FactoryTalk Linx Gateway if you need to: 

• Use FactoryTalk Linx as a data server for OPC clients. 
• Use FactoryTalk View SE as a data server for OPC clients to access HMI 

server tags (such as alarm, derived, and system tags) and direct 
references. 
Important: • FactoryTalk Linx Gateway service starts and stops from the machine on which it 

is installed. 
• FactoryTalk Linx Gateway supports OPC client notification under normal 

shutdown conditions. However, it is the OPC client's responsibility to provide a 
mechanism to detect when it is no longer connected to the server and flag data 
as bad quality. 

• Your access to, and actions within, FactoryTalk Linx Gateway are controlled by 
FactoryTalk Security settings.  

Only one FactoryTalk Linx Gateway is permitted to run on a given computer. 
The activation type determines feature support and the maximum capacity of 
unique tags that can be added to the FactoryTalk Linx Gateway server. The tag 
limit is for all unique tags, including active, inactive, and valid tags. However, 
the OPC DA service and UA service tag limits are separate; a 5,000 tag limit 
activation can simultaneously serve 5,000 tags to DA clients and 5,000 tags to 

What is FactoryTalk Linx 
Gateway? 
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UA clients. All FactoryTalk Linx Gateway activations support a capacity of up 
to 20 simultaneous OPC DA or OPC UA client connections. 

FactoryTalk Diagnostics and FactoryTalk Diagnostics Counter Monitor 
provide alerts when FactoryTalk Linx Gateway has reached the maximum tag 
capacity. This capacity can be increased with additional activations. Refer to 
About Activations on page 55 for more information about activations. 

Before FactoryTalk Linx Gateway version 6.00.00, here are the available 
activations: 

Activation Name Activation Tag Limit FactoryTalk Directory Activates FactoryTalk 
Linx Data Bridge 

FactoryTalk Gateway Distributed RSOPCD.UNLTD No fixed limit Local or Network Station or 
Distributed 

N 

FactoryTalk Gateway Distributed 70K RSOPCD.70000 70,000 Local or Network Station or 
Distributed 

N 

FactoryTalk Gateway Distributed 32000 RSOPCD.32000 32,000 Local or Network Station or 
Distributed 

N 

FactoryTalk Gateway Station 32000 RSOPCS.32000 32,000 Local N 
FactoryTalk Gateway Distributed 5000 RSOPCD.5000 5,000 Local or Network Station or 

Distributed 
N 

FactoryTalk Gateway Station 5000 RSOPCS.5000 5,000 Local N 
FactoryTalk Gateway Distributed 1500 RSOPCD.1500 1,500 Local or Network Station or 

Distributed 
N 

FactoryTalk Gateway Station 1500 RSOPCS.1500 1,500 Local N 

From FactoryTalk Linx Gateway version 6.00.00, only the four activations 
below are available for new users. However, the other legacy activations used 
in previous versions of the product are still supported. 

Activation Name Activation Tag Limit FactoryTalk Directory Activates FactoryTalk 
Linx Data Bridge 

FactoryTalk Linx Gateway Professional LINXGW.PROFESSIONAL No fixed limit Local or Network Station or 
Distributed 

Y 

FactoryTalk Linx Gateway Distributed LINXGW.DISTRIBUTED 32,000 Local or Network Station or 
Distributed 

N 

FactoryTalk Linx Gateway Standard LINXGW.STANDARD 5,000 Local or Network Station  N 
FactoryTalk Linx Gateway Basic LINXGW.BASIC 1,000 Local or Network Station  N 

For more information regarding OPC, refer to the OPC Foundation Web site: 
https://opcfoundation.org 

Because FactoryTalk Linx Gateway enables OPC clients to connect to 
FactoryTalk applications, it is important to understand some basic concepts 
about FactoryTalk. For more detailed information about FactoryTalk, refer to 
the FactoryTalk Services Platform Help. 

Formerly known as FactoryTalk Automation Platform, the FactoryTalk 
Services Platform is an underlying architecture and set of services that 
Rockwell Automation software products build upon. 

The FactoryTalk Services Platform: 

Overview of basic concepts 

FactoryTalk Services 
Platform 

https://opcfoundation.org/
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• Provides common services (such as diagnostic messages, health 
monitoring services, access to real-time data) and shares plant 
resources (such as tags and graphics) throughout an automation 
system. 

• Allows defining plant-floor resources once, and then allows 
simultaneous access to those resources across product boundaries. 

• Supports centralized security services. 

The FactoryTalk Services Platform includes the following components: 

• FactoryTalk Directory 
• FactoryTalk Live Data 
• FactoryTalk Diagnostics 
• FactoryTalk Administration Console 
• FactoryTalk Security 
• FactoryTalk Activation Manager 

FactoryTalk Directory allows products to share a common address book, 
which finds and provides access to plant-floor resources, such as data tags 
and graphics. 

The FactoryTalk Services Platform includes two separate directories: a Local 
Directory and a Network Directory. In a Local Directory, a Directory Server, 
all project information, and all participating software products are located on 
a single computer. Local applications cannot be shared across a network. A 
Network Directory organizes project information from multiple FactoryTalk 
products across multiple computers on a network. 

FactoryTalk Live Data manages connections between FactoryTalk products 
and data servers. It reads values from and writes values to OPC Unified 
Architecture (UA), OPC Classic Data Access (DA), and Live Data servers on 
behalf of client software products, such as FactoryTalk View and FactoryTalk 
Transaction Manager. 

FactoryTalk Diagnostics collects and provides access to activity, status, 
warning, and error messages generated throughout a FactoryTalk system. 

FactoryTalk Administration Console is an optional, stand-alone tool that 
enables you to configure and manage FactoryTalk-enabled applications. 

FactoryTalk Security offers centralized security services that provides the 
ability to control access to your automation system. Your access to, and 
actions within, the FactoryTalk Linx Gateway tool are controlled by 
FactoryTalk Security settings. Refer to Secure FactoryTalk Linx Gateway using 
FactoryTalk Security on page 69 before attempting to configure FactoryTalk 
Linx Gateway. 

FactoryTalk Activation Manager provides a secure, software-based system for 
activating Rockwell Automation software products and managing software 
activation files. 

FactoryTalk Directory 

FactoryTalk Live Data 

FactoryTalk Diagnostics 

FactoryTalk Administration 
Console 
FactoryTalk Security 

FactoryTalk Activation 
Manager 
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An application organizes project information, including elements such as 
data servers, HMI servers, and alarm and event servers, and makes it available 
to FactoryTalk-enabled software products that support the same FactoryTalk 
Directory type. 

• Network applications are held in a FactoryTalk Network Directory. 
Project information and participating software products can be 
located on multiple computers distributed across a network. All of the 
computers participating in a particular Network application share a 
common Network Directory Server located on a network computer. 

• Local applications are held in a FactoryTalk Local Directory. Project 
information is located on a stand-alone computer and is available only 
to software products installed on that same local computer. Local 
applications cannot be accessed remotely and cannot share project 
information with a Network application. 

 

Important: • Ensure all components intended for use in the same FactoryTalk 
system support the same FactoryTalk Directory types. 

• The installed FactoryTalk Linx Gateway activation may limit 
support for FactoryTalk Directory types. For details on which 
FactoryTalk Directory types are supported by a certain 
activation, see Activation types on page 56. 

 

 

Important: If there is a possibility that a client will attempt to access tags during setup, before 
continuing, shut down all OPC clients and inhibit FactoryTalk Linx Gateway services 
using FactoryTalk Linx Gateway Configuration Tool > Server Configuration. This 
prevents the services from automatically starting while making changes. 

Use the following checklist to guide you through the process of setting up and 
using FactoryTalk Linx Gateway. 

 Step Description Refer to: 
 1. Read and understand the FactoryTalk Linx Gateway 

Getting Results Guide. 
 

 2. Verify your personal computer meets the minimum 
hardware and software requirements. 

System requirements on page 17 

 3. Install FactoryTalk Linx Gateway. Install FactoryTalk Linx Gateway on 
page 17 

 4. Install a valid FactoryTalk Linx Gateway activation. About Activations on page 55 

 5. Configure FactoryTalk Security, if required. FactoryTalk Services Platform Help 

 6 Create a FactoryTalk application (or point to an 
existing application). 

FactoryTalk Services Platform Help 

Application types 

Quick start: Set up and use 
FactoryTalk Linx Gateway 
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 Step Description Refer to: 
 7. Add a FactoryTalk Linx data server or an HMI server. FactoryTalk View Site Edition Help 

or FactoryTalk Services Platform 
Help. 

 8. Create a shortcut between the FactoryTalk 
application and the server or controller. 

FactoryTalk View Site Edition Help 
or FactoryTalk Services Platform 
Help. 

 9. Start FactoryTalk Linx Gateway by clicking Start > 
Programs > Rockwell Software > FactoryTalk Linx 
Gateway > FactoryTalk Linx Gateway 
Configuration. 

Start FactoryTalk Linx Gateway 

 10. Select the scope using the FactoryTalk Linx 
Gateway Select FactoryTalk Directory dialog box. 

About the FactoryTalk Linx Gateway 
Scope Selection dialog box on page 
34 

 11. Configure OPC UA server endpoint in UA Server 
Endpoints tab 

FactoryTalk Linx Gateway Help 

 12. When the OPC client makes a connection with 
FactoryTalk Linx Gateway, enter FactoryTalk Linx 
Gateway as the server name to which you wish to 
connect. If the OPC client supports browsing, select 
FactoryTalk Linx Gateway from the list of available 
servers. 

OPC client documentation 

 13. Run the OPC client and select the tags you want to 
access (up to, but not exceeding, the activation 
count). 

OPC client documentation 
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Chapter 2 

Install FactoryTalk Linx Gateway 

The FactoryTalk Linx Gateway installation DVD provides wizards to guide you 
through the installation process.  

FactoryTalk Linx Gateway supports two installation methods: Setup wizard 
installation and automated installation with command line syntax. This 
chapter uses the Setup wizard installation method to illustrate the steps. The 
automated installation with command line syntax reduces user interaction 
and provides command line parameters to install FactoryTalk Linx Gateway. 
See Install FactoryTalk Linx Gateway with command line syntax on page 59.  

This chapter contains the following information: 

• System requirements 
• Where to install FactoryTalk Linx Gateway 
• Install FactoryTalk Linx Gateway for the first time 
• Update an existing system 
• Install Remote FactoryTalk Linx Gateway 

 

To use FactoryTalk Linx Gateway, your personal computer must meet the 
following minimum hardware and software requirements: 

 

FactoryTalk Linx Gateway requires the following hardware: 

• Intel® Core i5 Standard Power processor  
• 4 GB of memory  

 

 

Tested FactoryTalk Linx Gateway OPC DA service update rates 

CPU and memory requirements for the FactoryTalk Linx Gateway OPC DA 
server increase as tags are set to active (up to the activation tag capacity) or as 
more clients connect to the server (up to the 20 connected client capacity). 
Rockwell Automation tests with the following update rates for a number of 
active tags. 

System requirements 

Hardware requirements 

Tested FactoryTalk Linx 
Gateway update rates 
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Processor Number of 
tags 

Scan rate of all tags Total CPU 
utilization 

Single 70,000 All data changing value every 250 msec 75% 
Dual-core 70,000 All data changing value every 250 msec 50% 
Dual-core 70,000 All data changing value every 1000 msec 20% 

These values are tested on a computer with a dual-core Intel® Core™ i3-2120 
processor, 3.3 GHz, with 4G of RAM. The single core test is run using only one 
of the cores to provide a basis for comparison. FactoryTalk Linx Gateway and 
FactoryTalk Linx are installed and configured on the same computer for the 
test. 

The largest impact on CPU utilization is the rate the data is changing even if 
the data server (in this case, FactoryTalk Linx) is local or remote to the 
FactoryTalk Linx Gateway. 

The total amount of memory used for the runtime tests was approximately 
700MB. Additional memory would be utilized if browsing occurred. 

Tested FactoryTalk Linx Gateway OPC UA service update rates 

CPU and memory requirements for the FactoryTalk Linx Gateway OPC UA 
server increase as tags are set to active (up to the activation tag capacity) or as 
more clients connect to the server (up to the 20 connected client capacity). 
Rockwell Automation tests with the following update rates for a number of 
active tags. 

Number of Active Tags Tested Update Rate (ms) 

50,000 500 
100,000 700 
150,000 1000 
200,000 1500 
250,000 2000 
300,000 2400 

350,000 3000 
400,000 3500 
450,000 4000 
500,000 4500 

These values are tested on a computer with a quad-core Intel Xeon E5-1607 v3 
processor, 3.2 Ghz, and 8 GB of RAM. 

FactoryTalk Linx Gateway is tested on operating systems installed 
from original Microsoft® media only. They run on the 64-bit versions of 
the following Windows® operating systems: 

• Windows 10 Professional (64-bit) 
• Windows 10 Enterprise (64-bit) 

Software requirements 
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See the Windows Lifecycle FAQ and Windows as a Service (WaaS) topics on 
the Microsoft® Web site for details regarding servicing requirements 
and other important information. 

• Windows 10 Semi-Annual Channel v1803, v1809, v1903, v1909, and 
v2004 

Windows 10 Semi-Annual Channel is governed by the Microsoft 
Modern Lifecycle Policy. Refer to the Microsoft Web site for details. 

• Windows 10 IoT Enterprise 2016 Long-Term Servicing Branch (LTSB) 
• Windows 10 IoT Enterprise 2019 Long-Term Servicing Channel (LTSC) 

Windows 10 Long-Term Servicing Channel is governed by the 
Microsoft Fixed Lifecycle Policy. Refer to the Microsoft Web site for 
details. 

• Windows Server 2012 Datacenter (64-bit) 
• Windows Server 2012 Standard (64-bit) 
• Windows Server 2012 R2 Datacenter (64-bit) 
• Windows Server 2012 R2 Standard (64-bit) 
• Windows Server 2016 Datacenter (64-bit) 
• Windows Server 2016 Standard (64-bit) 
• Windows Server 2019 Datacenter (64-bit) 
• Windows Server 2019 Standard (64-bit) 

**Supported with the Allen-Bradley 61xx family of Industrial 
Computers or CompactLogix™ 5480 family of controllers. 

For additional information about Windows 10 Support for the 
FactoryTalk Suite of Rockwell Software products, refer to 
Knowledgebase Document ID: IN4493 - Windows 10 Support for the 
FactoryTalk Suite of Rockwell Software products 

 

 

 

FactoryTalk Linx Gateway version 6.20.00 (CPR 9 SR 12) has been 
tested with, and is compatible with, the following Rockwell 
Automation® products when used on the same computer: 

• FactoryTalk® Activation Manager version 4.04.14 
• FactoryTalk Services Platform version 6.20.00 
• FactoryTalk View version 12.00.00 
• FactoryTalk® Linx™ version 6.20.00 

 

 

 

Software compatibility 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/964391
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/964391
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FactoryTalk Linx Gateway Setup wizard supports to automatically install a 
series of Rockwell software and the necessary prerequisite software, 
including: 

Rockwell Software 
• FactoryTalk Services Platform version 6.20.00 (CPR 9 SR 12) 
• FactoryTalk Activation Manager version 4.04.14 
• FactoryTalk Alarms and Events version 6.20.00 (CPR 9 SR 12) 
• FactoryTalk Linx version 6.20.00 (CPR 9 SR 12) 
• Rockwell Automation USB CIP Driver v3.18.06 (for 32-bit operating 

systems) 
• Rockwell Automation x64 Driver v2.01.01 (for 64-bit operating systems) 

Prerequisite software 
• FactoryTalk Diagnostics version 6.20.00 
• Microsoft .NET Framework 4.6.2 
• Microsoft Visual C++ 2017 Redistributable (x86) 14.15 
• Microsoft Visual C++ 2017 Redistributable (x64) 14.15 
• Microsoft SQL Server 2012 Native Client 11.4 
• Microsoft SQL Server 2012 Native Client x64 11.4 
• Microsoft ODBC Driver 13.1 for SQL Server 13.1.811 
• Microsoft ODBC Driver 13.1 for SQL Server x64 13.1.811 
• OPC Local Discovery 1.03.400 
• OPC .NET API 2.01 
• Windows Firewall Configuration Utility 1.00.13 
• Wibu CodeMeter Runtime Kit v6.90 

 

FactoryTalk Linx Gateway version 6.00.00: 

• Adds OPC UA data access (non-secured endpoint). 
• Provides read access to CIP Energy Object information. 

FactoryTalk Linx Gateway version 6.10.00: 

• Supports FactoryTalk Security to control configuration 
access/changes. 

• Supports FactoryTalk Audit tracking for configuration changes. 
• Supports OPC UA Secured endpoints with signing and encryption. 

FactoryTalk Linx Gateway version 6.20.00: 

• Adds the ability to read/write device data (e.g. PowerFlex Drive, E300 
Motor Protector, etc.) using FactoryTalk Linx CIA Messaging.  
FactoryTalk Linx Gateway also provides the ability to control access to 
this option. 

Prerequisite software 

System features 
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• Adds the ability to allow OPC UA clients accessing multiple values of an 
array tag in a single action by configuring the "Index Range" 
parameter. For example, add an item [shortcut]Tag with index range 
1:3 returns the values of Tag[1], Tag[2], and Tag[3] together. 

• Adds the ability to allow OPC UA clients to directly access the tag 
information without browsing the tag in a client application. This is 
achieved by accessing the tag by entering the object node ID. 

• Supports customized outgoing certificate, import and the ability to 
create a certificate signing request for external Certificate Authority 
(CA) to sign. 

• Adds the ability to allow users to choose the specific activation that will 
be requested on startup. 

For FactoryTalk Local Directory applications and network station, you must 
install FactoryTalk Linx Gateway on the local computer. 

In a FactoryTalk Local Directory application and network station, all project 
information and security settings are located on a single computer, and the 
FactoryTalk-enabled system cannot be shared across a network. A FactoryTalk 
Linx Gateway Local Directory and network station, however, can support 
remote OPC clients. Products such as FactoryTalk View Site Edition (SE) 
Station and RSLogix use the Local Directory. 

A FactoryTalk application directories can be configured as Local, Network 
Station, or Network Distributed. These options are determined by the 
capabilities defined by the license/activation that is being used. 

1. Local – Small application where the FactoryTalk Linx or FactoryTalk 
Linx OPC UA Connector communications service is operated on the 
same workstation with FactoryTalk Linx Gateway. A local application is 
configured with a single level where all communications services are 
defined at the same top level (no areas are supported). 

2. Network Station – This configuration uses the Network directory, with 
all of the communications services defined on the same workstation 
with FactoryTalk Linx Gateway. A network station application permits 
areas to be created to improve the organization of the application (This 
type of configuration can be used with software like FactoryTalk View 
SE Station or FactoryTalk Historian which does not support Local 
directory). 

3. Network Distributed – This type of directory permits communications 
services to be located on multiple / different workstations from 
FactoryTalk Linx Gateway. Up to ten (10) of each type of 
communications services (FactoryTalk Linx and FactoryTalk Linx OPC 
UA Connector) can be defined in a system. These communications 
services can be configured as redundant to support high availability 
configurations (This type of configuration can be used with software 
like FactoryTalk View SE Distributed). 

Where to install 
FactoryTalk Linx Gateway 
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Depending on your requirements, FactoryTalk Linx Gateway installation 
options for Local FactoryTalk Directory applications include the following: 

To use FactoryTalk Linx as a data server to HMI and other third-party OPC 
clients, FactoryTalk Linx Gateway, FactoryTalk Linx, and FactoryTalk 
Directory are installed on the same machine as shown in the following 
diagram: 

 

For FactoryTalk View Site Edition (SE) applications that need to serve OPC 
data, FactoryTalk View SE Station can also be installed on the same machine, 
as shown in the following diagram. This also provides the benefit of 
FactoryTalk View SE Station features, such as alarm and derived tags and 
direct references. Plus, either FactoryTalk Linx or FactoryTalk View SE Station 
can be used as a data server. 
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For FactoryTalk Network Directory applications, you can install FactoryTalk 
Linx Gateway on any computer. 

A FactoryTalk Network Directory organizes project information and security 
settings from multiple FactoryTalk-enabled products across multiple 
computers on a network. When a Network Directory is configured on a 
computer, that computer can then be used as a Network Directory Server, or it 
can be made a client of a Network Directory Server configured on a different 
computer on the network. Products such as FactoryTalk View SE Distributed 
and FactoryTalk Transaction Manager use the Network Directory. 

Tip: In FactoryTalk Network Directory applications, you can choose from 
multiple computers to install FactoryTalk Linx Gateway. It is recommended 
that you install FactoryTalk Linx Gateway and the client on the same 
computer, instead of using Remote OPC across the network. Because 
FactoryTalk Live Data is used as the network protocol in what is 
considered to be a more robust and secure fashion than Remote OPC. 

Depending on your requirements, FactoryTalk Linx Gateway provides many 
installation options for FactoryTalk Network Directory applications. 

To connect to multiple FactoryTalk Linx servers or multiple FactoryTalk View 
SE Distributed servers, FactoryTalk Linx Gateway, FactoryTalk Linx, and 
FactoryTalk Directory can be distributed over different machines, as shown in 
the following diagram: 

In this example, one FactoryTalk Linx Gateway is serving all clients. If a 
system requires 32,000 or more tags, use a no fixed limit tag activation and 
refer to the FactoryTalk Linx Gateway Release Notes > Application Notes for 
tested hardware and update rates. 

You can have multiple FactoryTalk Linx Gateway servers point to the same 
scope in the same FactoryTalk Directory to provide redundancy for each other. 
The client code controls the switching between the FactoryTalk Linx Gateway 
servers. 

FactoryTalk Linx Gateway supports redundant FactoryTalk Linx data servers 
and HMI servers. Refer to the FactoryTalk Services Platform Help for more 
information. 

 





 

 Rockwell Automation Publication FTLG-GR001C-EN-E - September 2020 25 
 

Chapter 3 

About Remote FactoryTalk Linx Gateway 

Remote FactoryTalk Linx Gateway enables an OPC DA client to access a 
remote OPC DA server like FactoryTalk Linx Gateway without installing 
Rockwell Automation software on the OPC DA client computer. It is intended 
for use with OPC DA clients that do not support server enumeration and 
cannot discover or identify remote OPC DA servers. 

During the install, the Remote FactoryTalk Linx Gateway installer configures 
the Windows Firewall and security settings to allow DCOM communications 
between the OPC DA client and Remote FactoryTalk Linx Gateway. 

Remote FactoryTalk Linx Gateway does not have a configuration interface. 
Remote FactoryTalk Linx Gateway does not support connections to OPC UA 
servers. A Remote FactoryTalk Linx Gateway installation is not required for an 
OPC UA client on one workstation to connect to the FactoryTalk Linx Gateway 
OPC UA service on another workstation. 

Install Remote FactoryTalk Linx Gateway on the same computer as an OPC 
DA client that does not support server enumeration. 

Shown below are multiple OPC DA clients connecting to a single FactoryTalk 
Linx Gateway OPC DA server. Remote FactoryTalk Linx Gateway is installed 
once per computer that hosts an OPC DA client. 

 

 

 

Where to install Remote 
FactoryTalk Linx Gateway 
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If you install Remote FactoryTalk Linx Gateway on a remote third party OPC 
client, you need to configure Windows firewall to allow connections with the 
FactoryTalk Linx Gateway server. This is automatically configured after 
installation of FactoryTalk Gateway version 3.90.00 and later. If you want to 
verify the setting or make changes, follow the steps below. 

Tip: The following procedure applies for Windows 7, Windows 8, Windows Server 2008 R2, and 
Windows Server 2012. 

To configure Windows firewall: 
1. Select Start > Control Panel > System and Security (View by: Category). 
2. In the Windows Firewall section, click Allow a program through 

Windows Firewall. 

For Windows 10 or Windows Server 2016, Type Allow an app through 
Windows Firewall in the Windows Search field, and then press Enter. 

3. In the Allowed Programs and features list, verify the program 
OPCTest.exe which FactoryTalk Linx Gateway provided, or your own 
application for remote connecting, is in the list. If you cannot find it in 
the list, you can click Allow another program to browse and add it to 
the allowed programs list. 

4. Click OK to save the changes and close the dialog box. 

 

You can install one or more Rockwell Automation software products to a 
single personal computer. 

Important: The user installing or configuring FactoryTalk Linx Gateway must have administrative rights 
in Windows on the computers where the software is being installed or configured. The 
Windows domain Administrator account has these rights, for example. 

To install FactoryTalk Linx Gateway software: 
1. Start your Windows operating system. 
2. Insert the FactoryTalk Linx Gateway DVD into the DVD-ROM drive. 
3. (optional) If FactoryTalk Linx Gateway Setup does not appear, start 

the setup utility: 

a. In Windows, select Start > Run. 

b. In Open, type x:\setup, where x is the letter of the drive containing 
the FactoryTalk Linx Gateway DVD-ROM, and then click OK. 

c. If Microsoft .NET Framework 4.0 or later is not installed on your 
computer, the Microsoft .NET Framework Setup dialog box shows. 
Click Install. 

4. In FactoryTalk Linx Gateway Setup, select a product to install from the 
drop down list. The available products are: 

Configure Windows firewall 
for Remote FactoryTalk 
Linx Gateway 

Install FactoryTalk Linx 
Gateway 
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• Gateway 

Select Gateway to install FactoryTalk Linx Gateway and all 
supporting FactoryTalk software on this computer. FactoryTalk Linx 
Gateway serves FactoryTalk application data from this computer to 
OPC DA and UA clients. 

• Remote Gateway 

Select Remote Gateway to install Remote FactoryTalk Linx Gateway. 
No other FactoryTalk software is installed on this computer. Remote 
FactoryTalk Linx Gateway enables an OPC DA client on this 
computer to access a remote OPC DA server. It is intended for use 
with OPC DA clients that do not support server enumeration and 
cannot discover or identify remote OPC DA servers. 

5. Choose either: 

• Install Now: Install FactoryTalk Linx Gateway and prerequisite 
software to the the default installation directory: C:\Program 
Files\Rockwell Software (for 32-bit operating systems) or 
C:\Program Files (x86)\Rockwell Software (for 64-bit operating 
systems). 

• Customize: Specify which software should be installed and select a 
different installation directory, then click Install. 

6. In End-User License Agreements, read the agreements, then select 
Accept all to continue the installation, or click Decline to return to the 
previous page. 

7. (optional) If prompted to restart your computer during the 
installation, click Restart now to restart your computer and continue 
the installation, or Restart later to suspend and exit the installation. 

8. If you are installing FactoryTalk Linx Gateway, Almost there appears. 
Select one of the following options, then click Next. 

• Select Activate your software to activate FactoryTalk Linx Gateway 
now. 

• Select Skip activation to activate FactoryTalk Linx Gateway later 
using FactoryTalk Activation Manager. For more information, refer 
to About Activations on page 55.  

If you are installing Remote Gateway, no activation is required. 

9. In That's it!, click Restart now to restart your computer and continue 
the installation, or Restart later to exit the installation. You must 
restart your computer before using FactoryTalk Linx Gateway. 
Meanwhile, you can also: 

• Click Installation Summary to see the installation details. 
• Click Register for updates to learn how to receive email updates 

about product patches. 
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• Click Download it free to install Adobe Acrobat Reader. Adobe 
Acrobat Reader is required to open the FactoryTalk Linx Gateway 
Getting Results Guide and other documents. 

10. The FactoryTalk Linx Gateway installation is complete. When you 
finish installing the software, remove the FactoryTalk Linx Gateway 
DVD from the DVD-ROM drive, and store it in a safe place. 

To uninstall FactoryTalk Linx Gateway software, do any of the following: 

• Open Programs and Features in Windows Control Panel, right-click 
FactoryTalk Linx Gateway and then click Uninstall. 

• Open Setup.exe, and then click modify or uninstall. 
• Open the Command Prompt window and type a command with the 

following syntax: 
Setup.exe [/Q | /QS] /Uninstall /Product="Gateway" 
Note: Components, such as FactoryTalk Activation Manager, that are shared with other 

products will not be uninstalled. 

For more information about command-line parameter, see Parameters on 
page 60. 

Note the following before upgrading FactoryTalk Linx Gateway: 

• The user installing or configuring FactoryTalk Linx Gateway must have 
administrative rights in Windows on the computers where the 
software is being installed or configured. 

• If you upgrade from RSOPC Gateway 1.00 (CPR 7), do not use 
Add/Remove Programs from Windows Control Panel to uninstall 
RSOPC Gateway 1.00 (CPR 7). Using this method to remove RSOPC 
Gateway 1.00 (CPR 7) deletes RSOPC Gateway 1.00 (CPR 7) 
configuration files. 

• If you upgrade from FactoryTalk Gateway v3.90 or earlier to 
FactoryTalk Linx Gateway v6.00 or later, uninstall FactoryTalk Gateway 
using Add/Remove Programs before installing FactoryTalk Linx 
Gateway. 

Perform the following steps to upgrade to the latest version of FactoryTalk 
Linx Gateway: 

1. Stop the FactoryTalk Linx Gateway services by selecting the Inhibit 
checkbox in FactoryTalk Linx Gateway Configuration Tool > Server 
Configuration. 

2. If FactoryTalk Diagnostics Counter Monitor is running, exit the 
program. 

3. Close the FactoryTalk Linx Gateway Configuration Tool. 
4. Insert the FactoryTalk Linx Gateway product DVD. Perform the 

installation steps as presented on the screen. 
5. Restart your computer. 

Uninstall FactoryTalk Linx 
Gateway 

Update an existing 
installation 

Before you begin 

Upgrade FactoryTalk Linx 
Gateway 
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Note: You must restart your computer after installing Rockwell Automation 
software products. If you are installing multiple products, you must 
restart your computer after all of the products are installed. 

 

Remote FactoryTalk Linx Gateway enables an OPC DA client to access a 
remote OPC DA server like FactoryTalk Linx Gateway without installing 
Rockwell Automation software on the OPC DA client computer. It is intended 
for use with OPC DA clients that do not support server enumeration and 
cannot discover or identify remote OPC DA servers. 

Remote FactoryTalk Linx Gateway does not have a configuration interface. 
Remote FactoryTalk Linx Gateway does not support connections to OPC UA 
servers. 

Shown below are multiple OPC DA clients connecting to a single FactoryTalk 
Linx Gateway OPC DA server. Remote FactoryTalk Linx Gateway is installed 
once per computer that hosts an OPC DA client. 

 

To install Remote FactoryTalk Linx Gateway, select Remote Gateway in 
FactoryTalk Linx Gateway Setup, then follow the installation instructions. 

 

Install Remote FactoryTalk 
Linx Gateway 





 

 Rockwell Automation Publication FTLG-GR001C-EN-E - September 2020 31 
 

Chapter 4 

Start FactoryTalk Linx Gateway and explore the 
user interface 

This chapter includes the following information: 

• Starting FactoryTalk Linx Gateway 
• About the FactoryTalk Linx Gateway Configuration dialog box 

Start FactoryTalk Linx Gateway by selecting Start > Programs > Rockwell 
Software > FactoryTalk Linx Gateway > FactoryTalk Linx Gateway 

Configuration. (Or click  on the FactoryTalk Administration Console 
menu bar.) The FactoryTalk Linx Gateway Configuration dialog box opens. 
The default setting exposes all projects in the directory under the Network 
node. 

Tip: To start or stop the FactoryTalk Linx Gateway service, you must be either 
a Windows Administrator or Power User of the computer. 

 

The FactoryTalk Linx Gateway Configuration dialog box shows the Server 
Configuration, OPC UA Server Endpoints, software revision and activation 
information, and certificate and diagnostic information. 

Note: If there is a possibility that a remote client can start the FactoryTalk Linx Gateway 
service, you must disable the FactoryTalk Linx Gateway service via the Windows 
Control Panel (or all of the OPC clients should be stopped or shut down) before you 
reconfigure the scope. This will prevent the service from automatically starting 
while you are making changes to the scope configuration. The default DCOM 
settings prohibit launching the FactoryTalk Linx Gateway remotely and is the 
recommended setup. 

Start FactoryTalk Linx 
Gateway 

About the FactoryTalk Linx 
Gateway Configuration 
dialog box 
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The FactoryTalk Linx Gateway Configuration dialog box contains the 
following information: 

 

 

Item Description 

 The File button contains information about: 
• Log On 
• Log Off 
• Exit FactoryTalk Linx Gateway Configuration. 

 The Help button contains information about: 
• Release Notes. 
• Help Content 
• Software version number. 
• Activation 
• Copyright 
• Contact information 

 The Server Configuration tab contains information about: 
• FactoryTalk Directory scope selection. 
• OPC UA server name, status, OPC discovery service URL, status, and service inhibit checkbox. 
• OPC DA server status and service inhibit checkbox. 

 The UA Server Endpoints tab contains information about: 
• OPC UA server name, port, and URL. 
• Security mode and policy. 
• Authentication settings. 
• Diagnostic logging settings. 
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Item Description 

 The Certificate Management tab contains information about: 
• Incoming certificate import, reject, trust, and remove button. 
• Outgoing certificate regenerate button. 
• Certificate properties 

 The FactoryTalk Diagnostic Log tab contains information about: 
• FactoryTalk Diagnostics information. 

 The Activation to be utilized lists all the activation types. The default option is "Automatic Selection" which FactoryTalk Linx Gateway selects the 
activation that supports the most tags. 

 Click OK to apply the changes and restart FactoryTalk Linx Gateway service. 

 Click Cancel to close the dialog box. 

 Click Help to access the FactoryTalk Linx Gateway Help. 

 

Use Server Configuration to set FactoryTalk application scope and global 
server properties for the FactoryTalk Linx Gateway service. 

Global Settings 
Field Description 

FactoryTalk Diagnostics Scope Sets the FactoryTalk Diagnostics path to an application. Tags from the selected application are made accessible to 
OPC clients through the UA or DA server. 
The supported scope will depend on the FactoryTalk Linx Gateway activation purchased. For more information on 
supported scopes and activation, see Activation types on page 56. 
Sets where the FactoryTalk Linx services reside, local to the FactoryTalk Linx Gateway host PC or distributed over 
the network. 

 

UA Server Settings 
Field Description 

Service Name Sets the OPC UA service name visible to OPC UA clients. 
Inhibit Inhibits or enables the OPC UA service. 

• Checked: Inhibits the OPC UA service from operating. 
• Unchecked: Enables the OPC UA service. (default) 

Discovery service URL Lists the URL at which the OPC UA service can be accessed. 
Tip: Copy the URL text into the OPC UA client that accesses information from the FactoryTalk Linx Gateway OPC UA 
service. 

Register with Discovery Service Sets whether the OPC UA service is listed as part of the local OPC UA discovery service. 

 

Server Configuration 
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DA Server Settings 
Field Description 

Inhibit Inhibits or enables the OPC DA service. 
• Checked: Inhibits the OPC DA service from operating. 
• Unchecked: Enables the OPC DA service. (default) 
 
Tip: If the system only utilizes one of the OPC services, Rockwell Automation recommends inhibiting the other 
service to reduce the impact on the host computer and eliminate unwanted communications. 

 

Use Select FactoryTalk Directory to select an application, area, or sub-area 
(also known as the scope) from the FactoryTalk Directory. Tags from the scope 
are presented to OPC UA and DA clients as node IDs for subscription. The 
top-level or root location in the FactoryTalk Directory tree is not a valid 
selection. 

Tip: • If the server scope is changed up or down a level in the FactoryTalk 
Directory tree, OPC clients may not be able to access tags from the 
original configuration. This is because the OPC browse interface 
provides node ID paths that are relative to the configured scope. After 
changing the scope, check all relative paths in client applications to 
determine if their values need to be updated. 

• You must inhibit the FactoryTalk Linx Gateway services before you can 
configure the scope. Note that if you do not have read permission, an 
error message opens when you configure scope. Refer to Secure 
FactoryTalk Linx Gateway using FactoryTalk Security on page 69. You 
must be logged into FactoryTalk to be able to configure the scope. If you 
have not already done so, you will be prompted to log in when you click 
Select. 

 

Use UA Server Endpoints to add, remove, and configure OPC UA server 
endpoint URLs and properties.  

Each endpoint defines a specific approach for accessing data from the 
FactoryTalk Linx Gateway OPC UA service. With the security mode and policy 
set to "None", only one endpoint is required. Future extensions will add 
functionality where multiple endpoints may be desirable to limit tag access 
via specific security constraints. 

UA Server Endpoints 
Field Description 

UA Server Endpoints A list of all configured OPC UA server endpoint URLs, their security modes, and security policies. 
Add Adds a new OPC UA server endpoint to the list. 
Remove Removes the highlighted OPC UA server endpoint from the list. 

 

Select FactoryTalk 
Directory 

UA Server Endpoints 
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Endpoint Properties 
Field Description 

Name Sets the name for the OPC UA server endpoint. The name must be unique. The server name displays in the 
OPC UA namespace and is included in the full tag path for all nodes provided by the server. 

Port Sets the port number for the OPC UA server endpoint. The port must be unique. The default port is 4990 and 
increments by 1 for each additional endpoint. 

URL Sets the network path to the OPC UA Server. The path must be in the format 
opc.tcp://hostname_or_ip:port/Endpoint/Name where 
hostname_or_ip, port, and /Endpoint/Name are replaced with the hostname or IP 
address, port number, and endpoint name of the OPC UA server. 
This URL must be provided to OPC UA client applications in order to connect to the FactoryTalk Linx Gateway 
UA service. 
The firewall on the FactoryTalk Linx Gateway OPC UA server must allow incoming connections to the 
selected port for the connection to succeed. 

Security Mode Displays the security method required for connections between OPC UA clients and the FactoryTalk Linx 
Gateway OPC UA server. 
• Sign: Use signature to secure the connection. 
• Sign & Encrypt: Use signature and encryption to secure the connection. 
• Sign + Sign & Encrypt: Use either signature or signature and encryption to secure the connection. 

Security Policy Displays whether security is required or optional for connections between OPC UA clients and the 
FactoryTalk Linx Gateway OPC UA server. 
There are three security algorithm suites: 
• Basic128Rsa15 
• Basic256 
• Basic256Sha256 

Anonymous Sets OPC UA clients' log on user group is Anonymous with read and write access. 

Limit to read-only access Sets the log on user group is Anonymous with only read access. 
FactoryTalk Security User Sets OPC UA clients' log on user group is FactoryTalk Security user with read and write access. The user is 

created in FactoryTalk Administration Console > System > Users and Groups. Username and password are 
needed. 

Log diagnostic message on tag write When enabled, FactoryTalk Linx Gateway will create a diagnostic or audit message every time a tag is 
written by an external OPC UA client. The default setting is disabled. 

Log as audit message When enabled, FactoryTalk Linx Gateway will create an audit message in the FactoryTalk Audit log with 
time-and date-stamped information to track changes that occurred during the operation of the system. 

Log as diagnostic message When enabled, FactoryTalk Linx Gateway will create a diagnostic message in the FactoryTalk Diagnostics log 
with time-and date-stamped information to help diagnose anomalies. 

 

Use About FactoryTalk Linx Gateway to identify the version of the 
FactoryTalk Linx Gateway user interface, OPC UA and DA servers, and OPC 
Foundation Discovery Service, or to view the activation type and grace period 
status. 

To open About FTLinx Gateway: 
1. From the Windows Start Menu, select All Programs > FactoryTalk 

Linx Gateway > FactoryTalk Linx Gateway Configuration. 
2. Click Help > About FactoryTalk Linx Gateway. 

About FactoryTalk Linx 
Gateway 



Chapter 4  Start FactoryTalk Linx Gateway and explore the user interface 
 

36 Rockwell Automation Publication FTLG-GR001C-EN-E - September 2020  
 

Revision 
Field Description 

FactoryTalk Linx Gateway User Interface Revision Lists the version number of the FactoryTalk Linx Gateway user interface 
on the local machine. 

FactoryTalk Linx Gateway OPC UA Server Revision Lists the version number of the FactoryTalk Linx Gateway OPC UA service 
on the local machine. 

FactoryTalk Linx Gateway OPC DA Server Revision Lists the version number of the FactoryTalk Linx Gateway OPC DA service 
on the local machine. 

OPC Foundation Discovery Service Revision Lists the version number of the OPC Foundation Discovery Service on the 
local machine. 

 

Use Certificate Management to view FactoryTalk Linx Gateway OPC UA 
server certificate information. 

FactoryTalk Linx Gateway creates a default, self-signed security certificate 
during installation. The security certificate is stored at 
C:\ProgramData\Rockwell\FTLinxGateway\PKI\own\cert_ftgw_op
cua_server.der on the host computer for the FactoryTalk Linx Gateway 
server. A custom security certificate can be created by generating a certificate 
signing request in FactoryTalk Linx Gateway and signed by an external 
trusted security authority and then imported to FactoryTalk Linx Gateway to 
replace the default certificate. 

 

Certificate properties 
Field Description 

Name Displays the name of the security certificate. 
Status Displays the certificate status, either Trusted or Rejected. 
Location Displays the path to the security certificate on the FactoryTalk Linx Gateway computer. 
Application Name Displays the application from where the certificate is presented. 
Organization Displays the organization name that submitted to CA when requesting the certificate. 
Application URI Displays the FactoryTalk Linx Gateway application URI associated with the security certificate. 
Domain Displays the workstation name. 

Subject Name Displays the subject properties on the certificate. For example, Common Name (CN). 
Valid From The date and time when the security certificate is valid. 
Expiration Time The date and time when the security certificate expires. 
Thumbprint A short sequence of bytes created by applying the cryptographic hash function to identify a certificate.  

 

Certificate actions 
Button Description 

Import Specify and import the certificate to be used as incoming certificate or outgoing certificate. 

Reject Move the specific certificate(s) from Trusted Certificates list to Rejected Certificates list. The client(s) cannot 
communicate with FactoryTalk Linx Gateway. 

Certificate Management 
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Button Description 

Remove Remove the specific certificate(s) from Trusted Certificates list or Rejected Certificates list. The client(s) cannot 
communicate with FactoryTalk Linx Gateway. 

Trust The specific certificate is added to Trusted Certificates list and the client can communicate with FactoryTalk Linx 
Gateway. 

Create CSR Create a Certificate Signing Request (CSR) and save the request as a .CSR file. 
Regenerate Create another certificate to renew the valid period. 

 

Use FactoryTalk Diagnostic Log to view historical error, warning, and 
information level diagnostic messages about the FactoryTalk Linx Gateway 
services on the current computer. 

FactoryTalk Diagnostic Log 
Button Description 

Refresh Clear the FactoryTalk Diagnostic Log and refresh diagnostic messages from the FactoryTalk Diagnostics server on the 
local computer. 

Launch FactoryTalk Diagnostic Viewer Starts the FactoryTalk Diagnostic Viewer to view diagnostic messages for all FactoryTalk devices and services, or to 
view diagnostic messages for a remote computer. 

 

 

 

FactoryTalk Diagnostic Log 
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Chapter 5 

Use FactoryTalk Linx Gateway to Access Data 

This chapter includes the following information: 

• Before you begin 
• Starting FactoryTalk Linx Gateway 
• Selecting the scope 
• Accessing data 

Before you can access data via FactoryTalk Linx Gateway, you must: 

1. Install and activate FactoryTalk Linx Gateway.  

For the detailed steps, refer to Install FactoryTalk Linx Gateway on 
page 17. 

2. Create a FactoryTalk application, or point to an existing application, in 
FactoryTalk Administration Console. 

For the detailed steps, refer to FactoryTalk Services Platform Help. 

3. Add a data server, for example, a FactoryTalk Linx data server. 

For the detailed steps, refer to FactoryTalk Services Platform Help. 

4. Add shortcuts to target controllers in FactoryTalk Linx. 

For the detailed steps, refer to FactoryTalk Linx Online Help. 

Start FactoryTalk Linx Gateway by selecting Start > Programs > Rockwell 
Software > FactoryTalk Linx Gateway > FactoryTalk Linx Gateway 

Configuration. (Or click  on the FactoryTalk Administration Console 
menu bar.) The FactoryTalk Linx Gateway Configuration dialog box opens. 
The default setting exposes all projects in the directory under the Network 
node. 

Tip: To start or stop the FactoryTalk Linx Gateway service, you must be either 
a Windows Administrator or Power User of the computer. 

 

The scope is the area or application from which you want to access data. The 
main FactoryTalk Linx Gateway Configuration dialog box shows the current 
scope. The supported scope will depend on the FactoryTalk Linx Gateway 
activation purchased. For more information on supported scopes and 
activation, see Activation types on page 56. 

A local scope means that only one instance of a FactoryTalk Linx data server 
can be configured, and resides on the local host computer. A network scope 
means that multiple FactoryTalk Linx data servers can be configured and may 

Before you begin 

Start FactoryTalk Linx 
Gateway 

Select the scope 
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be distributed across the network. If the FactoryTalk Linx Gateway is 
providing data to a FactoryTalk View SE application, activations that support 
the local or network application must be installed for FactoryTalk Linx 
Gateway and FactoryTalk View SE. 

 

Tip: • If there is a possibility of a remote or local client requesting tag data from FactoryTalk 
Linx Gateway, you must disable the FactoryTalk Linx Gateway service via the Windows 
Control Panel, or stop or shut down all of the OPC clients before you reconfigure the 
scope. This will prevent the service from automatically starting while you are 
configuring the scope. The default DCOM settings prohibit launching the FactoryTalk 
Linx Gateway OPC <DA> service remotely and is the recommended setup. 

• You must stop the service before you can configure the scope. Note that if you do not 
have read permission, an error message opens when you configure scope. Refer to the 
FactoryTalk Linx Gateway Help. You must be logged into FactoryTalk to be able to 
configure the scope. If you have not already done so, you will be prompted to log in 
when you click Select. 

• When using a new system, or if you need to change the scope, use the FactoryTalk 
Administration Console. 

To select the scope: 
1. In Server Configuration, next to FactoryTalk Diagnostics Scope, click 

Select. 
2. In Select FactoryTalk Directory, select either the Network or Local 

FactoryTalk Directory. 
3. From the FactoryTalk Directory tree, select an application or area. 
4. Select OK. 
5. In Server Configuration, select Apply. 
6. In FactoryTalk Linx Gateway Configuration, click Yes to restart the 

FactoryTalk Linx Gateway services and apply the scope change. 

Your access to, and actions within, the FactoryTalk Linx Gateway tool are 
controlled by FactoryTalk Security settings. Refer to Secure FactoryTalk Linx 
Gateway using FactoryTalk Security on page 69 before attempting to 
configure FactoryTalk Linx Gateway. 

Once a FactoryTalk Directory scope has been selected and the FactoryTalk 
Linx Gateway service is running, OPC UA and DA clients can read and write 
the data provided from the FactoryTalk Linx Gateway services. Refer to your 
OPC client documentation for more information. 

Prerequisites: 
1. In the scoped FactoryTalk application, add a FactoryTalk Linx data 

server. 
2. In the scoped FactoryTalk application, create a shortcut from the 

application to the server hosting the tag data. 

Access the data 
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a. In FactoryTalk View Studio or FactoryTalk Administration Console, 
open Communication Setup. 

b. In Device Shortcuts, click Add. 

c. (optional) Type a unique name for the shortcut. 

d. In the communications heirarchy tree in the right-hand pane, click 
the device that contains the tag data, then click Apply. 

e. Click Yes to apply changes. 

f. In Shortcut Type, select a type of shortcut. The default value is 
Processor. 

g. Click OK to close Communication Setup. 

For more information about shortcuts, see FactoryTalk Linx Help. 

3. (optional) On the FactoryTalk Linx Gateway host PC, use Server 
Configuration to verify the FactoryTalk Linx Gateway OPC UA or OPC 
DA service is running. 

To access data from FactoryTalk Linx Gateway: 
1. Start an OPC UA or DA client. 
2. Configure the OPC UA or DA client to connect to the FactoryTalk Linx 

Gateway service. 

• For OPC DA clients, this is done by entering or browsing to the 
hostname or IP address of the FactoryTalk Linx Gateway server. 

• For OPC UA clients, this is done by entering or browsing to an OPC 
UA Endpoint URL. If security is required, the client may need to 
accept the FactoryTalk Linx Gateway security certificate. 

3. In the OPC client, add a data group. 
4. In the OPC client, add one or more data items to the data group, up to 

but not exceeding the FactoryTalk Linx Gateway activation capacity. 

For more information on FactoryTalk Linx Gateway activations, see Activation 
types on page 56. 
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Chapter 6 

Use FactoryTalk Diagnostics Counter Monitor 
with FactoryTalk Linx Gateway 

This chapter includes the following information: 

• About FactoryTalk Diagnostics Counter Monitor 
• Run FactoryTalk Diagnostics Counter Monitor 
• Create a snapshot file 
• Use FactoryTalk Diagnostics Counter Monitor to troubleshoot 

FactoryTalk Linx Gateway 

FactoryTalk Diagnostics Counter Monitor is installed with FactoryTalk 
Services Platform. This stand-alone tool shows diagnostic counter 
information as well as OPC clients, groups, and corresponding items. 

FactoryTalk Diagnostics Counter Monitor shows diagnostic information 
about the FactoryTalk Linx Gateway runtime operation: 

• Diagnostic counters are displayed as properties at the FactoryTalk Linx 
Gateway, client, and group levels. 

• Individual diagnostic items are displayed as children of their 
corresponding group connection. 
Tip: FactoryTalk Diagnostics Counter Monitor shows diagnostics for 

FactoryTalk Linx Gateway, FactoryTalk Live Data, and FactoryTalk Linx (if 
installed). 

 

About FactoryTalk 
Diagnostics Counter Monitor 
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The FactoryTalk Diagnostics Counter Monitor main window contains three 
areas: 

 

 

Item Description 

 Navigator 
Workstations are manually added to or removed from a tree in the Navigator area. If FactoryTalk Linx or FactoryTalk Linx Gateway is installed on a 
workstation, FactoryTalk Diagnostics Counter Monitor automatically detects and shows them on the tree under the associated workstation. 

 Data 
The values of the selected diagnostic items are displayed in the Data area. 
The Data area contains the following columns: 
• Name: At the root, provider, and client levels, this is the name of the diagnostic counter. At the group level, this is the tag name. 
• Value: At the root and provider levels, this is the returned data value of the diagnostic counter. At the group level, this indicates the status of the 

tag: Active or Inactive. 
Note that neither the list of names nor their values can be modified. 
For a description of each counter, refer to the FactoryTalk Diagnostics Counter Monitor Help. 

 Viewer, which contains two tabs: 
• Troubleshooting Resources 

The Help is integrated into FactoryTalk Diagnostics Counter Monitor using this viewer. 
• FactoryTalk Diagnostics Messages 

Error messages associated with FactoryTalk Diagnostics Counter Monitor are logged to FactoryTalk Diagnostics. These messages are also 
displayed on the FactoryTalk Diagnostics Messages viewer. This enables you to see if there is any correlation between the logged messages and 
the values of the diagnostic items displayed in the Data area. Note that FactoryTalk Diagnostics messages are displayed for the local workstation 
only. 

To further aid in diagnosing problems, an integrated snapshot feature 
captures diagnostic values into an .xml file. This enables you to send this 
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information to Rockwell Automation Technical Support if you need 
troubleshooting assistance. Refer to Create a snapshot file on page 46. 

Tip: FactoryTalk Diagnostics Counter Monitor is currently supported for desktop servers 
only. Windows CE is not supported in this release. 

Keep the following in mind while using FactoryTalk Diagnostics Counter 
Monitor: 

• Inactive tags are displayed with a value of Inactive. 
• If a group's state is inactive, then the items within that group are 

inactive, regardless of what appears on the screen. However, if a 
group's state is active, it does not affect the state of any items within 
that group; that is, items within that group may be active or inactive. 

• If client and group names are supplied by the client, then those names 
will be shown in the FactoryTalk Diagnostics Counter Monitor 
Navigator area. 

• Duplicate items are given a numerical suffix (that is, itemname (#)) to 
distinguish them and are treated as unique tags. Duplicate items are 
numbered sequentially as they are added, regardless of the Group to 
which they are added. For more information, refer to FactoryTalk 
Diagnostics Counter Monitor Help. 

Note the following before you begin using FactoryTalk Diagnostics Counter 
Monitor: 

• FactoryTalk Linx Gateway must be installed and running on one or 
more host computers on the network.  

• The diagnostics client must have access to a workstation that has an 
application with diagnostic items associated with it. A client must be 
accessing those diagnostic items in order for them to be shown on 
FactoryTalk Diagnostics Counter Monitor. 

• To prevent FactoryTalk Linx Gateway performance degradation, run 
only one instance of FactoryTalk Diagnostics Counter Monitor at a 
time, and close the tool when you have finished troubleshooting. 

To run FactoryTalk Diagnostics Counter Monitor: 
1. Start FactoryTalk Diagnostics Counter Monitor. 

Click Start > Programs > Rockwell Software > FactoryTalk Tools> 
FactoryTalk Diagnostics Counter Monitor.  
The FactoryTalk Diagnostics Counter Monitor main window opens. By 
default, the Navigator area shows a single root item called System 
Diagnostics.  

2. Add a workstation to the Navigator area. 

Right-click on the root in the Navigator area, and select Add 
Workstation. The Enter Workstation IP Address/Hostname dialog 
box opens. 

Run FactoryTalk 
Diagnostics Counter Monitor 
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Tip: Alternately, you can add a workstation by clicking the root in the 

Navigator area and clicking . 

Enter the hostname or the device name of the workstation that 
contains the diagnostics you want to view, and click OK. For more 
information about the Enter Workstation IP Address/Hostname 
dialog box, refer to FactoryTalk Diagnostics Counter Monitor Help. 
Note that the default workstation is localhost. 

3. Expand the workstation to expose the installed data provider(s). 
4. Click on any diagnostic item in the tree. The diagnostic counters 

associated with the selected item are shown in the Data area of the 
FactoryTalk Diagnostics Counter Monitor main window. While the 
item is selected, the counter values are updated automatically as new 
values are received.  

Snapshot files aid in troubleshooting by capturing all diagnostic values in an 
.xml file, which can then be sent to Rockwell Automation Technical Support. 
The .xml file contains the values of all of the diagnostic counters, whether 
expanded and displayed or not. Refer to the FactoryTalk Diagnostics Counter 
Monitor Help for more information. 

To create a snapshot file: 
1. Click File > Save Snapshot. 
2. Select the location to which you want to save the snapshot file. The 

default location is the C: drive. 
3. Enter a filename, or use the default filename, FTDiagData.xml. 
4. Click Save. 

To use FactoryTalk Diagnostics Counter Monitor to troubleshoot FactoryTalk 
Linx Gateway: 

1. Start FactoryTalk Linx Gateway. (Start > Programs > Rockwell 
Software > FactoryTalk Linx Gateway > FactoryTalk Linx Gateway 

Configuration or click  on the FactoryTalk Administration 
Console menu bar.) 

2. Start FactoryTalk Diagnostics Counter Monitor. (Start > Programs > 
Rockwell Software > FactoryTalk Tools > FactoryTalk Diagnostics 
Counter Monitor.) 

3. Click FactoryTalk Linx Gateway OPC UA Server or FactoryTalk Linx 
Gateway OPC UA Server in the FactoryTalk Diagnostics Counter 
Monitor Navigator area. 

4. Use the counters displayed in the Counter area to see the high-level 
status of the FactoryTalk Linx Gateway interactions with the clients: 

• Activation: Verify the value indicates the correct activation. 
• Count against Activation: Verify there are tags present (value > 0). 
• Service Status: Verify the service is Running. 

Create a snapshot file 

Use FactoryTalk 
Diagnostics Counter Monitor 
to troubleshoot FactoryTalk 
Linx Gateway 
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• Selected Scope: Verify the scope is correct for your application. 
• Data Callbacks: Verify that tags are updating (values increase). If 

tags are not updating, there are a number of possible reasons: 

• The data values are static. 
• The controller is in PROGRAM mode. 
• Groups or items at the client level are inactive. 

5. Click the FactoryTalk Diagnostics Messages tab in the Viewer area. 
For more information about using this resource, refer to the 
FactoryTalk Diagnostics Counter Monitor Help. 
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Chapter 7 

Troubleshoot FactoryTalk Linx Gateway 

This chapter includes the following information: 

• What to check first if you’re having problems 
• Troubleshooting tools for FactoryTalk Linx Gateway 
• Troubleshooting topics 
• How to contact technical support 

Does your FactoryTalk Linx Gateway meet the minimum hardware and 
software requirements? Refer to Install FactoryTalk Linx Gateway on page 17 
for these requirements. 

Is the software installed correctly? Refer to Install FactoryTalk Linx Gateway 
on page 17 for installation instructions. Restart your computer after installing 
the software before you begin using FactoryTalk Linx Gateway. 

Do you have a valid activation file? Check the FactoryTalk Diagnostics log. An 
information message is logged if the activation file is not detected by the 
system when you launch FactoryTalk Linx Gateway. Refer to the FactoryTalk 
Services Platform Help for information about FactoryTalk Diagnostics 
messages. Refer to About Activations on page 55 for information about 
activations. 

Is the OPC UA client successfully connected to the FactoryTalk Linx Gateway 
server? Check if the OPC UA client use the same security mode and policy 
with FactoryTalk Linx Gateway. For example, Sign & Encrypt and 
Basic256Sha256. Make sure the OPC UA client trust the FactoryTalk Linx 
Gateway certificate: cert_ftgw_opcua_server.der. Refer FactoryTalk 
Linx Gateway Online Help for information about secure OPC UA client and 
certificate validation. 

To help you isolate, diagnose, and correct any problems you may experience 
using FactoryTalk Linx Gateway, use the following troubleshooting tools: 

Use the FactoryTalk Linx Gateway Configuration Tool to view status and 
diagnostic information. Server Configuration displays the server status. 
About > FactoryTalk Historical Diagnostics displays FactoryTalk Diagnostics 
messages scoped to the FactoryTalk Linx Gateway service. 

FactoryTalk Diagnostics provides the ability to log errors, warnings, and other 
status messages generated throughout a FactoryTalk-enabled system to a 
central location called an event log. If you encounter a problem, you can 
review the events in the log that led up to the problem to assist in determining 

What to check first if you 
have problems 

Troubleshooting Tools 

FactoryTalk Linx Gateway 
Configuration Tool 

FactoryTalk Diagnostics 
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the cause. Or, you can monitor the log to identify potential problems and take 
corrective action before a problem occurs. 

Note that FactoryTalk Diagnostics messages are displayed for the local 
workstation only. 

Refer to the FactoryTalk Services Platform Help for more information about 
FactoryTalk Diagnostics and the event log. Refer to the FactoryTalk Linx 
Gateway Help for more information about diagnostic messages specific to 
FactoryTalk Linx Gateway. 

FactoryTalk Diagnostics Counter Monitor aids in troubleshooting OPC 
connections from third-party products. It shows diagnostic information 
about the FactoryTalk Linx Gateway runtime operation. The FactoryTalk 
Diagnostics event log and Help are integrated into this tool. Refer to Use 
FactoryTalk Diagnostics Counter Monitor with FactoryTalk Linx Gateway on 
page 43 for more information. Refer to the FactoryTalk Diagnostics Counter 
Monitor Help for individual counter descriptions. 

FactoryTalk Live Data Test Client is a utility to test your OPC DA connection 
after you have configured the FactoryTalk Linx Gateway. This utility is 
installed automatically with FactoryTalk Services Platform. This utility can 
only test connections to the FactoryTalk Linx Gateway OPC DA service. 

OPC Test Client is a utility that enables you to test your data connections if 
you are using remote OPC Client functionality. This utility is installed 
automatically as part of Remote FactoryTalk Linx Gateway on the FactoryTalk 
Linx Gateway product DVD. 

The OPC Foundation provides an OPC UA sample client, available for 
download at https://opcfoundation.org/developer-tools/developer-kits-
unified-architecture/sample-applications. 

The topics below provide information to help you troubleshoot FactoryTalk 
Linx Gateway. 

If you are experiencing activation problems, refer to: 

• About Activations on page 55 
• FactoryTalk Linx Gateway troubleshooting topics in FactoryTalk Linx 

Gateway Help. 
• FactoryTalk Activation Manager troubleshooting topics in FactoryTalk 

Activation Manager Help. 

If you are experiencing problems with FactoryTalk Security, refer to: 

• Secure FactoryTalk Linx Gateway using FactoryTalk Security on page 
69 

• Troubleshooting topics in FactoryTalk Services Platform Help. 

FactoryTalk Diagnostics 
Counter Monitor 

FactoryTalk Live Data Test 
Client 

OPC Test Client 

Troubleshooting topics 

FactoryTalk Linx Gateway 
activations 

FactoryTalk Security 

https://opcfoundation.org/developer-tools/developer-kits-unified-architecture/sample-applications
https://opcfoundation.org/developer-tools/developer-kits-unified-architecture/sample-applications
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If you are experiencing problems starting or stopping the FactoryTalk Linx 
Gateway service, verify your Windows user account privileges. You must have 
administrative rights to start and stop the service. 

If you are experiencing problems with bad quality data, no data being 
returned, data is stale or frozen, or tags do not appear during an OPC client 
tag browse operation, use the following steps to isolate and correct the 
problem: 

1. If testing an OPC DA connection, verify that the FactoryTalk 
connection is working. 

a. If testing an OPC DA connection, use the FactoryTalk Live Data Test 
Client to connect directly to FactoryTalk (not FactoryTalk Linx 
Gateway). Then, verify that you can browse and add an item. If there 
are no problems, then the issue is with FactoryTalk Linx Gateway, not 
FactoryTalk. 

2. Test the connection. 

a. If testing an OPC DA connection, run OPC Test Client or FactoryTalk 
Live Data Test Client. Note that you may need to change the DCOM 
settings if you use OPC Test Client. 

a. Navigate to the application containing the data server that you are 
trying to use. 

b. Browse, and put some tags on scan. If you cannot browse for 
tags, then the data server is not configured correctly or the 
devices that the data server is pointing to are not configured or 
connected. 

c. If testing an OPC UA connection, use the OPC Foundation UA 
Sample Client to connect to FactoryTalk Linx Gateway. If the sample 
client connects, the issue is not with FactoryTalk Linx Gateway but 
with the OPC UA client. 

3. Verify that the tags are not hidden by the External Access attribute (set 
in Logix Designer, starting with version 18 for controllers that support 
External Access). For more information on the External Access 
attribute, refer to the documentation for version 18 (CPR 9 SR 2) or 
later of the application. Note that if the External Access attribute for a 
tag in a controller is changed from None to Read or Read/Write, you 
may need to restart the data client to see the tag. If the External Access 
attribute for a tag in a controller is changed from Read or Read/Write 
to None, the Quality changes to Out of Service for that tag. 

4. Check the FactoryTalk Linx Gateway configuration. 

a. Open FactoryTalk Linx Gateway. 

FactoryTalk Linx Gateway 
service (starting and 
stopping) Data quality 
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b. Verify that the server is running. If you are experiencing stale or 
frozen data, it is possible that the client was not notified that 
FactoryTalk Linx Gateway service had stopped. 

c. Verify that the proper application, including scope (network or 
local), is selected. 

d. Verify that you have the correct activation for the application you 
are trying to run. 

5. Check the FactoryTalk Diagnostics log. Some events to check for: 

a. A controller is in the process of downloading a new program. The 
FactoryTalk Diagnostics log will indicate if a new program has been 
downloaded and specify the path. 

b. The activation is incorrect for the application or you have exceeded 
the activation capacity. 

c. The tag does not exist. Any currently non-existing tags should be 
logged as not existing in the controller. 

6. Check the FactoryTalk Linx configuration. 

a. Open FactoryTalk Administration Console or FactoryTalk View Studio. 

b. Right-click the FactoryTalk Linx server and select Properties. Verify 
the correct computer hosting FactoryTalk Linx is shown. 

c. Double-click Communication Setup. 

d. Verify that there is a shortcut configured and that it has the correct 
name. 

e. Click the shortcut and verify that it is pointing to the expected 
device within the communication tree. 

f. SS6. Right-click the network you are using and select Start 
Browsing. If the device disappears from the Communication tree, 
then FactoryTalk Linx is no longer finding the device. Verify that the 
device is online. 

7. If testing an OPC DA quality issue, verify that DCOM access settings 
are configured correctly. 

8. Verify any firewall software is configured to allow access to 
FactoryTalk Linx Gateway OPC DA and UA service ports. 

9. Verify that the scope and FactoryTalk Linx shortcuts are correctly 
configured. Refer to Access the data on page 40. 

If the above steps do not resolve your problem, please contact Rockwell 
Automation Technical Support. 

There are many factors to consider when diagnosing communication 
problems: 

• Computer effect on communication 

Communication slow or 
unreliable 
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• Memory, disk space, and anti-virus scans can affect computer 
performance. Refer to System requirements on page 17. 

• Firewalls and switches can completely or partially block 
communication. 

• The typical timing factor for communication updates is the CPU 
load. Rockwell Automation recommends a 40% maximum steady 
state CPU loading. This balances utilization of the hardware and 
gives enough bandwidth for peak loading. 

• Multiple clients effect on communication 

• The packaging of data to OPC standards takes computer CPU power 
to achieve, and this can be significant depending on the data 
loading. 

• The number of clients requesting data from a single OPC data 
server can also significantly impact computer CPU loading, 
particularly if they are not requesting the same items (tags). 

• Clients creating and destroying groups can significantly impact 
CPU usage. 

• Network effect on communication 

• An incorrect network configuration can reduce communication 
effectiveness. Verify your network configuration as well as your 
installation. Refer to Install FactoryTalk Linx Gateway on page 17. 

• Controller effect on communication 

• For ControlLogix controllers, data requests are handled by a CPU 
separate from the control program CPU. (FlexLogix controllers have 
one CPU to handle all tasks.) However, eventually these data 
requests are handled by the controller program. This affects 
communication efficiency since the controller is performing higher 
priority tasks and handles communication when CPU time is 
available. You can monitor task utilization using Logix 5000 Task 
Monitor on the Logix Designer utilities DVD. 

• Data requests are sent to controllers via a network port (for 
example, Ethernet, ControlNet, DeviceNet). For ControlLogix 
Ethernet communication, the ENET, ENBT, EN2T, or EWEB 
module is required. These modules could be a bottleneck to 
communication depending on the number of data requests and the 
number of requesting clients. 

• Tag structure in a controller program can also have a significant 
impact on communication efficiency. Refer to your Logix Designer 
documentation. 

• The communication time slice setting within the controller (set 
using Logix Designer application) will affect communication. You 
may need to increase the setting value. 
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• The way OPC clients request data can either help or hinder the 
ControlLogix Optimized Packets process. Refer to your 
ControlLogix controller documentation. 

• Offline or disconnected controllers will cause additional retries and 
diagnostics to be logged. Inhibit a controller using FactoryTalk Linx 
if it will not be present in the system for an extended period of time. 

• DCOM effect on communication 

OPC DA is based on DCOM, therefore: 

• Changing DCOM security settings may stop the OPC DA service 
from working. 

• Changing DCOM security settings may prevent a client from 
browsing tags through the OPC UA service. 

• If the server and client become disconnected (either via a physical 
network disconnect or a software disconnect), there is a hard-coded 
6-minute time-out notification. 

• If the server and client are reconnected, the OPC connection is not 
automatically reconnected to the original objects. Therefore, servers 
and clients may require restarting. 

If you are experiencing a problem with, or have a question about, FactoryTalk 
Linx Gateway, please consult the Help and Release Notes. If you cannot find 
the answer, contact Rockwell Automation Technical Support. 

440-646-3434 

http://www.rockwellsoftware.com 

http://support.rockwellautomation.com 

Support staff are available 8 a.m. to 5 p.m. EST, Monday through Friday, 
except holidays. 

Before you call, you should be at your computer and be prepared to give the 
following information: 

• The product serial number and version number. These can be found by 
clicking Start > Settings > Control Panel > Add/Remove Programs and 
clicking FactoryTalk Linx Gateway. 

• The type of hardware you are using. 
• The version of Windows operating system you are using. 
• The exact wording of any messages that appeared on your screen. 
• What happened and what you were doing when the problem occurred. 
• How you tried to solve the problem. 

 

Contact Rockwell 
Automation Technical 
Support 
Phone 
Worldwide web 

Hours of operation 

Before you call 
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Appendix A 

About Activations 

Rockwell Automation Windows-based software products are copy protected 
and require an activation key, located in an activation file, to run the software. 

When you launch FactoryTalk Linx Gateway, the software checks for the 
activation file. If a valid activation cannot be found, an error is logged to 
FactoryTalk Diagnostics and FactoryTalk Linx Gateway operates under a grace 
period. Refer to FactoryTalk Services Platform Help for more information 
about grace periods. 

This appendix includes the following information: 

• Activate FactoryTalk Linx Gateway 
• Activation types 

FactoryTalk Linx Gateway supports activating software during the software 
installation. The new Installation Setup Wizard contains an Software 
Activation check box. This no longer requires you to open FactoryTalk 
Activation Manager to activate the software. 

To activate your copy of FactoryTalk Linx Gateway in the FactoryTalk Linx 
Gateway Installation Setup Wizard, perform the following steps: 

1. Perform the steps in Install FactoryTalk Linx Gateway on page 17 to 
install FactoryTalk Linx Gateway software. 

2. On the Rockwell Software Setup dialog box in the Installation Setup 
Wizard, select the Activate your software check box and click Finish. 

3. On the Software Activation dialog box, enter the product key from 
your Activation Certificate. The serial number should have been 
automatically added. If the serial number is not automatically added, 
enter the serial number. 

4. Select Activate locally to activate FactoryTalk Linx Gateway on a single 
computer, or select Activate using a dongle to activate FactoryTalk 
Linx Gateway on any computer by using a dongle. 
Tip: The Activate using a dongle option requires that you have a dongle to lock 

the activation. 

5. Click Continue. 

You can still activate FactoryTalk Linx Gateway via FactoryTalk Activation 
Manager by clicking the Explore other options link in the Software Activation 
dialog box. The link provides direct access to the FactoryTalk Activation 
Manager software. To activate your copy of FactoryTalk Linx Gateway in the 

Activate FactoryTalk Linx 
Gateway 
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FactoryTalk Activation Manager, click Get New Activations and follow the 
instructions in the FactoryTalk Activation Manager. 

For more information on using the FactoryTalk Activation Manager, click 
More or Help in the FactoryTalk Activation Manager. 

EvRSI activation is replaced by FactoryTalk Activation Manager. If you are 
using EvRSI activation, please contact your local Rockwell Automation Sales 
office or Technical Support for information on migrating your activations to 
FactoryTalk Activation Manager. 

For Rockwell Automation Technical Support in the U.S., call (440) 646-3434. 

Outside the U.S., visit http://www.rockwellautomation.com/locations. 

The activation type determines feature support and the maximum capacity of 
unique tags that can be added to the FactoryTalk Linx Gateway server. The tag 
limit is for all unique tags, including active, inactive, and valid tags. However, 
the OPC DA service and UA service tag limits are separate; a 5,000 tag limit 
activation can simultaneously serve 5,000 tags to DA clients and 5,000 tags to 
UA clients. All FactoryTalk Linx Gateway activations support a client capacity 
of up to 20 simultaneous OPC DA or 110 OPC UA client connections (the 
suggested connection quantity is 20 based on the previous testing). But the 
actual capacity for OPC client connections could vary based on available 
computer resources and the amount of information being requested. 

If a valid activation cannot be found, FactoryTalk Linx Gateway operates 
under a grace period. 

Note: Grace period is a 7 days free trial of FactoryTalk Linx Gateway during which, a 
user has the tag subscription capability equals to the "Professional" activation. 
When the grace period is over, the OPC UA/DA clients cannot connect to the 
FactoryTalk Linx Gateway. 

If an activation limits FactoryTalk Linx Gateway to a Local FactoryTalk 
Directory, a Network FactoryTalk Directory scope cannot be selected. If a 
Network FactoryTalk Directory is already selected and the activation is 
downgraded, FactoryTalk Linx Gateway displays an error and writes a 
diagnostic message to FactoryTalk Diagnostics. 

A FactoryTalk application directories can be configured as Local, Network 
Station, or Network Distributed. These options are determined by the 
capabilities defined by the license/activation that is being used. 

1. Local – Small application where the FactoryTalk Linx or FactoryTalk 
Linx OPC UA Connector communications service is operated on the 
same workstation with FactoryTalk Linx Gateway. A local application 
is configured with a single level where all communications services 
are defined at the same top level (no areas are supported). 

2. Network Station – This configuration uses the Network directory, with 
all of the communications services defined on the same workstation 
with FactoryTalk Linx Gateway. A network station application permits 

Activation types 
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areas to be created to improve the organization of the application (This 
type of configuration can be used with software like FactoryTalk View 
SE Station or FactoryTalk Historian which does not support Local 
directory). 

3. Network Distributed – This type of directory permits communications 
services to be located on multiple/different workstations from 
FactoryTalk Linx Gateway. Up to ten (10) of each type of 
communications services (FactoryTalk Linx and FactoryTalk Linx OPC 
UA Connector) can be defined in a system.  These communications 
services can be configured as redundant to support high availability 
configurations (This type of configuration can be used with software 
like FactoryTalk View SE D istributed). 

When checking for valid activations, FactoryTalk Linx Gateway finds and uses 
the activation with the highest feature support. The selected activation type is 
visible in the About tab of FactoryTalk Linx Gateway Configuration. 

From FactoryTalk Linx Gateway version 6.00.00, only the four new activations 
(FactoryTalk Linx Gateway Professional, FactoryTalk Linx Gateway 
Distributed, FactoryTalk Linx Gateway Standard, and FactoryTalk Linx 
Gateway Basic) are available for new users. However, the other legacy 
activations used in previous versions of the product are still supported. All the 
activations are shown in the table below from top to bottom as highest to 
lowest priority. 

Activation Name Activation Tag Limit FactoryTalk Directory Activates FactoryTalk 
Linx Data Bridge 

FactoryTalk Linx Gateway Professional LINXGW.PROFESSIONAL No fixed limit Local or Network Station or 
Distributed 

Y 

FactoryTalk Gateway Distributed RSOPCD.UNLTD No fixed limit Local or Network Station or 
Distributed 

N 

FactoryTalk Gateway Distributed 70K RSOPCD.70000 70,000 Local or Network Station or 
Distributed 

N 

FactoryTalk Linx Gateway Distributed LINXGW.DISTRIBUTED 32,000 Local or Network Station or 
Distributed 

N 

FactoryTalk Gateway Distributed 32000 RSOPCD.32000 32,000 Local or Network Station or 
Distributed 

N 

FactoryTalk Gateway Station 32000 RSOPCS.32000 32,000 Local N 
FactoryTalk Gateway Distributed 5000 RSOPCD.5000 5,000 Local or Network Station or 

Distributed 
N 

FactoryTalk Linx Gateway Standard LINXGW.STANDARD 5,000 Local or Network Station  N 
FactoryTalk Gateway Station 5000 RSOPCS.5000 5,000 Local N 
FactoryTalk Gateway Distributed 1500 RSOPCD.1500 1,500 Local or Network Station or 

Distributed 
N 

FactoryTalk Gateway Station 1500 RSOPCS.1500 1,500 Local N 
FactoryTalk Linx Gateway Basic LINXGW.BASIC 1,000 Local or Network Station  N 

If a system requires 32,000 or more tags, use a no fixed limit activation and 
refer to the FactoryTalk Linx Gateway Release Notes > Application Notes for 
tested hardware and update rates. 
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Tip: To check the number of tags added to FactoryTalk Linx Gateway, use 
FactoryTalk Diagnostics Counter Monitor. 
• For OPC DA service tags, view the Count against Activation counter. 
• For OPC UA service tags, view the Total Items in Subscription counter. 

If you have multiple clients subscribing the same 
tags, the tags being used against the activation 
limit should be counted separately. For example 
there are five clients subscribing 1000 tags, then 
the total activation limit used is 5000 tags. 

 

As a best practice, Rockwell Automation recommends using a shared 
concurrent activation, which is locked to a networked activation server 
computer, but shared by client computers on the network. Refer to 
FactoryTalk Services Platform Help for more information. 

Note that if you have multiple FactoryTalk Linx Gateway instances using 
different tag counts, each FactoryTalk Linx Gateway instance must be 
activated using its own specific activation file to ensure that each FactoryTalk 
Linx Gateway instance receives the correct tag count activation. 

Tip: FactoryTalk Batch v9.00.00 (CPR 9) and later supports direct 
communication between FactoryTalk Live Data and plant-floor controllers 
and devices, removing the need for FactoryTalk Linx Gateway. 
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Appendix B 

Install FactoryTalk Linx Gateway with command 
line syntax 

Besides the Setup Wizard installation, FactoryTalk Linx Gateway also 
supports automated installation using command line syntaxes: unattended 
installation. You can typically use the unattended installation during large-
scale rollouts when it might be too slow and costly to have administrators or 
technicians interactively install the FactoryTalk Linx Gateway software on 
individual computers.  

In the unattended installation, you enter a specified command line with 
multiple parameters. During the installation process, instead of prompting 
you for installation and configuration information interactively, the process 
follows the parameters you specified in the command lines.  

To install FactoryTalk Linx Gateway in the unattended mode, follow the steps 
below. The steps may vary slightly. Follow the on-screen instructions that 
apply to your operating system. 

1. Close all open Windows programs. 
2. Open the Command Prompt window as administrator. 
3. In the Command Prompt window, navigate to D:, where D: is the drive 

containing the FactoryTalk Linx Gateway installation DVD or 
installation package, and press Enter. 
Tip: The User Account Control dialog box may show after you press Enter, 

click Yes to continue. The silent installation requires the Windows 
Administrator privilege. 

4. Type a command line with the following syntax: 
Setup.exe {/Q | /QS} 

/IAcceptAllLicenseTerms 
[/AutoRestart] 
[/SetupLanguage=language] 
/Product=product_name 
[/InstallDrive=drive] 
[/SerialNumber=serial_number] 
[/ProductKey=product_key] 
[/Version=product_version] 

5. Press Enter. The installation process starts with the parameters you 
specified. 

6. For detailed description about each parameter, see Parameters on page 
60. You can also type Setup /? in the Command Prompt window, and 
press Enter to view the help information of all parameters and 
examples. 

Perform unattended 
installation 



Appendix B  Install FactoryTalk Linx Gateway with command line syntax 
 

60 Rockwell Automation Publication FTLG-GR001C-EN-E - September 2020  
 

The parameters and values are not case sensitive. If the value includes spaces, 
you need to enclose it in quotation marks (" "). 

/Q 

One of /Q and /QS is required if /Record is not specified. 

Installs the product in the silent mode without any user interface. 

/QS 

One of /Q and /QS is required if /Record is not specified. 

Installs the product in the unattended mode without user interaction 
during installation, and shows the progress, errors, or complete 
messages on the user interface. 

/IAcceptAllLicenseTerms 

Required for /Q or /QS.  

Specifies that you read and acknowledge all license agreements, and 
agree to continue the installation. 

/AutoRestart 

Optional. If specified, the computer will be restarted automatically 
after the installation, if a restart is required to complete the 
installation. 

The parameter is ignored if a restart is not required. 

/SetupLanguage=language 

Optional. Specifies which language will be displayed during the 
installation process. The value must be the one of ENU, CHS, DEU, 
ESP, FRA, ITA, JPN, KOR, or PTB. 

If omitted, the default language is the user or system user interface 
language. 

/Record 

Optional. Records your inputs to a recording file. 

/Playback 

Optional. Plays back a recording file. 

/IgnoreWarning 

Optional. If specified, the setup will ignore  and continue. 

/Product=product name 

Required. Specifies which product will be installed. The product name 
must be one of the following: 

• Gateway 

Parameters 
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• Remote Gateway 

/Uninstall=Product name 

Optional. Uninstall the product. 

/InstallDrive=drive 

Optional. Specifies the installation drive. 

If omitted, the default drive and location are:  

• C:\Program Files (x86)\Rockwell Software (64-bit) or 
• C:\Program Files\Rockwell Software (32-bit). 

/SerialNumber=serial_number 

Optional. Specifies the serial number that is required if you want to get 
activation keys during installation. 

/ProductKey=product_key 

Optional. Specifies the product key that is required if you want to get 
activation keys during installation. 

/Version=product_version 

Optional. Specifies the version corresponding to the product version 
that the SerialNumber and ProductKey are able to activate if you want 
to get activation keys during the installation. 

If the version information is omitted, the installer uses a default 
version which is the most recent product version available when 
retrieving the activation. 

The following examples show how to use the commands during the 
unattended installation. 

Example 1 
Setup.exe /Q /IAcceptAllLicenseTerms /Product="Gateway" 

means: 

The FactoryTalk Linx Gateway unattended installation uses the default 
settings during the installation process, with no user interface. 

Example 2 
Setup.exe /QS /IAcceptAllLicenseTerms /AutoRestart 
/SetupLanguage=CHS /Product="Gateway" /InstallDrive=D: 
/SerialNumber=0123456789 /ProductKey=ABCDE-FGHIJ 
/Version=6.00.00 

means: 

Examples 
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• During the installation, the progress, error, or complete messages 
show on user interfaces. The displayed language is Chinese. 

• FactoryTalk Linx Gateway will be installed to D:\Program Files 
(x86)\Rockwell Software if you are using a 64-bit operating system, or 
D:\Program Files\Rockwell Software if you are using a 32-bit 
operating system. 

• The setup will get activation keys during installation if the serial 
number 0123456789 and product key ABCDE-FGHIJ are valid. 

• After the installation, if a restart is required, the computer will be 
restarted automatically. 

Example 3 
Setup.exe /Q /Uninstall /Product="Gateway" 

means: 

• The software is uninstalled silently with no user interface. 
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Appendix C 

About FactoryTalk Linx 

This appendix includes an overview of FactoryTalk Linx. 

FactoryTalk® Linx™ is a FactoryTalk® Live Data server and communications 
service designed to deliver control system information from Allen-Bradley® 
control products to the Rockwell Automation FactoryTalk® software portfolio 
and Studio5000® design software.  While FactoryTalk Linx can communicate 
with most Allen-Bradley Programmable Logic Controllers (PLC®) and many 
other control products, it is specifically optimized to work with Logix 5000™ 
Programmable Automation Controllers (PAC) using EtherNet/IP. This gives 
the fastest data rates and capacity possible, while minimizing the impact on 
automation networks and control system operation. FactoryTalk Linx 
provides a scalable solution that can support small applications running on a 
single computer with a single controller, to large distributed and even 
redundant data server configurations communicating with many controllers. 

FactoryTalk Linx: 

• Is delivered and installed with the FactoryTalk Services Platform 
(FTSP) which is included with most Rockwell Automation software 
products. FactoryTalk Linx is also delivered within the PanelView Plus 
Electronic Operator Interface (EOI) terminal’s firmware. 
Tip: The FactoryTalk Services Platform Installation includes several useful 

tools.  Use FactoryTalk Live Data Test Client to interface with FactoryTalk 
Linx to read and write data directly to controllers. For more information 
about FactoryTalk Live Data Test Client, see FactoryTalk Services Platform 
Online Help. 

• Is accessed as an embedded component within each software package 
that utilizes its services. Configure FactoryTalk Linx using the 
Communication Setup editor launched from a FactoryTalk application 
design environment (e.g. FactoryTalk View Studio) or from the 
FactoryTalk Administration Console.   

• Starting with version 6.00.00, EtherNet/IP network drivers can be 
configured directly from the FactoryTalk Linx Network Browser 
control embedded within Studio 5000 and other Rockwell Automation 
design software. 

• Provides access to controller and device data from any FactoryTalk 
application using FactoryTalk Live Data. 

• Is highly optimized for Logix 5000 communications. 
• Starting with version 5.30.00, supports FactoryTalk Alarms and Events. 

For more information about FactoryTalk Alarms and Events, See 
FactoryTalk Alarms and Events Online Help. 

About FactoryTalk Linx 
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• Starting with version 5.30.00, network applications provide the option 
of specifying a secondary, or redundant, server to take over when the 
primary server fails. 

• Starting with version 5.60.00, reads data directly from devices using 
parameters specified in the device’s Electronic Data Sheed (EDS) file 

• Starting with version 5.70.00, receives data from Logix 5000 
controllers directly via unsolicited message. 

• Starting with version 5.70.00, is able to communicate with Micro800 
controllers 

• Starting with version 5.80.00, reads energy usage information from 
devices that support the ODVA CIP Energy object. 

• Starting with version 5.90.00, reads Logix 5000 tag extended 
properties (e.g. @Min, @Max, @Description) and deliver them to 
FactoryTalk View applications. With FactoryTalk Linx version 6.10.00, 
this capability is enhanced to improve read performance and adds the 
ability to provide a description using information indirectly associated 
with a tag. This enables a FactoryTalk View SE client to obtain 
descriptions for tag elements that do not directly have a description 
assigned. This is similar to the description pass-through capability of 
Studio 5000 Logix Designer. 

• Starting with version 5.90.00, removes Logix 5000 tag requests when 
their external access is switched to no access in Logix Designer, and the 
tags can be removed from the controller while it is operating. 

• Starting with version 5.90.00, permits communications to specific 
Logix 5000 shortcuts to be inhibited to reduce the impact of Logix 
5000 controllers that are disabled or off-line 

• Starting with version 6.00.00, provides access to Logix 5000 tag based 
alarm attributes (e.g. @Alarm…)  

• Offers a variety of communication drivers and routing options. 
• Supports Local applications (also called stand-alone applications) for 

smaller systems, and Network applications (also called distributed 
applications) for larger systems. 

• Starting with version 6.00.00, enables the configuration of two 
redundant shortcut paths to a single Logix 5000 controller to support 
high availability systems that desire to retain communications when a 
path through a network becomes disabled. 

• Starting with version 6.00.00, permits configuration of two shortcut 
paths to the primary and secondary Logix 5000 controllers in a 
redundant ControlLogix revision 31.5x system to retain 
communications when a redundancy switchover occurs.  

• FactoryTalk Linx 6.00.00 added the ability to provide communications 
and browsing services for Studio 5000 and ControlFLASH. FactoryTalk 
Linx version 6.10.00 extends this functionality to support the 
Connected Components Workbench (CCW) version 12.00.00 and 
FactoryTalk AssetCentre version 9.00.00. 
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• FactoryTalk Linx version 6.00.00 updated both the Virtual Backplane 
and USB drivers and had them signed by Microsoft to permit them to 
operate on a workstation with Windows 10 Secure boot enabled. 
FactoryTalk Linx version 6.10.00 extends this functionality to include 
the drivers associated with the 1784-PCICS and 1784-PCKTS cards. In 
FactoryTalk Linx version 6.20.00, 1784-PKTX driver signed by 
Microsoft to support Windows 10 secure boot. 

• FactoryTalk Linx version 6.10.00 added a new standalone version of 
FactoryTalk Linx Network Browser that can be launched from the 
Windows Start Menu. Previously this component was only available 
from within other Rockwell Automation software (For example. 
ControlFLASH and Studio 5000 Logix Designer). The Network 
Browser can be used to visualize the network to determine which 
devices are active in the system. 

• FactoryTalk Linx version 6.10.00 added FactoryTalk Security Product 
Policy to provide more control over the configuration for authorized 
users. 

• FactoryTalk Linx version 6.10.00 added logging of FactoryTalk Audit 
messages to track configuration changes of FactoryTalk Linx. 

• FactoryTalk Linx version 6.10.00 supports a new capability in 
Logix5000 V32 controllers to change the names of tags and structure 
members on a running controller. When FactoryTalk Linx detects the 
rename operation, it will immediately stop requesting the old names 
and provide an appropriate error status back to the FactoryTalk 
software that requested the data, making it easier to locate other 
software that is impacted by the rename operation. 

• FactoryTalk Linx version 6.10.00 added the ability to receive 
unsolicited messages using PLC-2 Unprotected Writes. This enables 
Logix5000 or legacy controllers to send information to a FactoryTalk 
software package using FactoryTalk Linx. 

• FactoryTalk Linx version 6.10.00 changes the default setting for the 
“listen on EtherNet/IP Encapsulation port” (port 44818) for its Ethernet 
driver so that FactoryTalk Linx will respond to network browse 
requests and receive unsolicited messages from Logix5000 controllers. 
RSLinx Classic version 4.00.01 or earlier allocated this port by default 
but was updated with versions 4.10.00 to not allocate the port to reduce 
the likelihood of a conflict between these two software packages.  

• FactoryTalk Linx version 6.10.00 added the ability to configure two 
independent instances of the data service on a single Windows 
operation system. It allows applications to have more tags, data clients 
(e.g. HMI clients), and/or controllers without affecting the other 
FactoryTalk Linx data server. 

• FactoryTalk Linx version 6.11.00 added the ability to establish secure 
encrypted communications with FactoryTalk Policy Manager using 
CIP security. See FactoryTalk Policy Manager Online Help for more 
information about CIP security. 
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• FactoryTalk Linx version 6.20.00 added the ability to access 
information inside of devices that support the Open Device Vendors 
Association (ODVA) Common Industrial Protocol (CIP), using the 
Class, Instance and Attribute (CIA) messaging with the CIP Object - 
Class/Instance/Attribute Message shortcut type. 

• The FactoryTalk Security Policy for FactoryTalk Linx was enhanced to 
control the user’s capabilities from the FactoryTalk Linx Network 
Browser and to control access to CIA Messaging. 

• In conjunction with FactoryTalk Linx Gateway, provides standard OPC 
connectivity into the FactoryTalk system for third-party products. For 
more information about FactoryTalk Linx Gateway, refer to the 
FactoryTalk Linx Gateway Help.FactoryTalk Linx version 6.20.00 adds 
the ability to access information inside of devices that support the 
Open Device Vendors Association (ODVA) Common Industrial 
Protocol (CIP), using the Class, Instance and Attribute (CIA) 
messaging with the CIP Object - Class/Instance/Attribute Message 
shortcut type. 

• Starting from version 6.20.00, FactoryTalk Linx supports tag 
communication with data types as LINT, ULINT, LREAL, USINT, 
UINT, and UDINT. 

• Starting from version 6.20.00, FactoryTalk Linx instance02 supports 
Logix-based Alarms and Events. 

• Starting from version 6.20.00, FactoryTalk Linx provides the ability to 
communicate using solicited messaging with Allen-Bradley controllers 
using PLC-5 or SLC-5 messaging over the DH+ network without having 
a 1784-PKTX card installed on the computer. This is achieved by using 
the 1756 EtherNet module bridging across a ControlLogix chassis to a 
DH+ network connected to a 1756-DHRIO module. 

• FactoryTalk Linx version 6.20.00 adds the ability to configure existing 
drivers in FactoryTalk Linx Browser > Configure Drivers dialog box. 

• FactoryTalk Linx version 6.20.00 adds the ability to view new CIP 
Identity Object Manufacturer information, which include Catalog 
Number, Manufacture Date, Hardware Revision, Warranty, and 
Series. 

• FactoryTalk Linx version 6.20.00 adds FactoryTalk Audit information 
to diagnose configuration changes made from the FactoryTalk Linx 
Network Browser. 

• FactoryTalk Linx version 6.20.00 adds the ability for FactoryTalk Linx 
Network Browser to browse through the 5094 IO HART modules and 
display HART connected devices in the topology. 

• FactoryTalk Linx version 6.20.00 adds the ability for the FactoryTalk 
Linx Network Browser to access Device Statistics to help diagnose 
devices. 

• FactoryTalk Linx version 6.20.00 adds the ability for the FactoryTalk 
Linx Network Browser to access Device Configuration to help 
configure port and network configuration of a device. 
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• FactoryTalk Linx version 6.20.00 adds the ability the ability for the 
FactoryTalk Linx Network Browser to launch an Internet browser to 
open the device embedded web page. 

• FactoryTalk Linx version 6.20.00 provides the ability for FactoryTalk 
and PanelView Plus V12 terminals to access four attributes @Name, 
@Quality, @Timestamp, and @Scope. 

• FactoryTalk Linx version 6.20.00 adds the ability for FactoryTalk and 
PanelView Plus V12 terminals to access PlantPAX Controller extended 
tag properties: @Library, @Instruction, @Label, @Area, @URL, and 
@Navigation. 

• Starting from version 6.20.00, FactoryTalk Linx changed to utilize a 
device’s Network Path to store location of the device in a system, 
which enables the user to configure and store the shortcut path using 
the device's IP address and slot number in a chassis.  

• FactoryTalk Linx version 6.20.00 provides Chinese, German, French, 
and Japanese localized user interface (the localized FactoryTalk Linx 
can only be installed when installing the same localized version of 
FactoryTalk View SE). 

• FactoryTalk Linx version 6.20.00 adds the ability to close unused 
connections after a specified time. 

• FactoryTalk Linx version 6.20.00 adds the ability to specify the max 
number of connections for a Processor shortcut connecting to 
PLC/SLC controllers using the DHRIO module. 

For more information, refer to FactoryTalk Linx Help. 
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Appendix D 

Secure FactoryTalk Linx Gateway using 
FactoryTalk Security 

This appendix includes the following information: 

• About FactoryTalk Security 
• Using FactoryTalk Security with FactoryTalk Linx Gateway 
• Securing tag write access for FactoryTalk Linx Gateway 

FactoryTalk® Security improves the security of your automation system by 
limiting access to those with a legitimate need. FactoryTalk Security 
authenticates the identities of users, and authorizes user requests to access a 
FactoryTalk system against a set of defined user accounts and access 
permissions held in the FactoryTalk network directory or FactoryTalk local 
directory. 

For help configuring security services, refer to FactoryTalk Services Platform 
Help. 

If you prefer not to use security services, you can grant all users full access to 
your automation system. For help overriding security services, refer to 
FactoryTalk Services Platform Help. 

The FactoryTalk Linx Gateway Configuration tool enables you to start or stop 
the FactoryTalk Linx Gateway service and configure the scope. To configure 
security for the tool, in the FactoryTalk Administration Console, right-click 
the network (the highest level of the tree), and select Security from the menu. 

The following example shows the steps to restrict a user from changing the 
scope: 

Before you begin: 
• Log in as Windows Administrator or Power User of the computer. 
• Obtain Read/Write/List Children permissions within the Common 

section of Security. 
• Log in to FactoryTalk. 

About FactoryTalk Security 

Secure the FactoryTalk Linx 
Gateway Configuration tool 



Appendix D  Secure FactoryTalk Linx Gateway using FactoryTalk Security 
 

70 Rockwell Automation Publication FTLG-GR001C-EN-E - September 2020  
 

To restrict a user from changing the scope: 
1. In the FactoryTalk Administration Console Explorer, right-click 

Network > Security. The Security Settings for Network dialog box 
opens. 

For local scope, right-click Local (THIS COMPUTER) > Security. The 
Security Settings for Local dialog box opens. 

2. On the Permissions tab, select View permissions by User and you can 
see all the user groups (Administrators, All Users, Anonymous Logon), 
highlight the user you want to restrict. 

3. From the Permissions for *** from All Computers list, click Common > 
Write, and select the Deny check box. 

4. Click OK. 

Runtime actions are browsing, reading, or writing to tags. You configure 
security governing these actions using the Anonymous Logon user account at 
either the application level or area level. 

To browse the directory and read the data, the Anonymous Logon user must 
have List Children and Read permissions within the Common section of 
Security. 

To write to tags, the Anonymous Logon user must have Write Value 
permissions within the Tag section of Security. 

Keep the following in mind when securing runtime actions: 

• Security for the FactoryTalk Linx Gateway is set at the FactoryTalk Linx 
Gateway level using the Anonymous Logon user account. Therefore, all 
clients that access that specific FactoryTalk Linx Gateway will have the 
same privileges. If different clients need different privileges, then a 
second FactoryTalk Linx Gateway will need to be configured on 
another computer. 

• Security is area-based. It is a best practice to have only one data server 
per area. This allows you to place different permissions on each area 
(data server). 

• When configuring the scope for the FactoryTalk Linx Gateway, you 
should select the FactoryTalk Application, not an area. Selecting the 
scope at the application level enables you to add areas to that 
application without having to change the scope. Changing a scope 
affects all the existing tag references that have been previously 
configured in the clients. 

• You can deny both Read and Write access to areas. This is shown in the 
following example. 

Example 
Assume a Network-scoped distributed system. This system has a 
FactoryTalk Application called MyFTApp that contains three areas and 
three data servers. 

Secure runtime actions 
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Assume the requirements for the OPC clients are: 

• Full access (Reads/Writes) allowed through FactoryTalk Linx. 
• No Reads allowed from the OPC client through RSLinx Classic. 
• No Writes allowed from the OPC client into the FactoryTalk View SE 

HMI (Reads are allowed). 

To meet these requirements: 

1. The selected scope (using the FactoryTalk Linx Gateway 
Configuration screen) should be Network/MyFTApp. (Selected 
Scope field shows Network/MyFTApp.) 

2. Security for Area1 (using the FactoryTalk Administration Console) 
should be configured as follows: 

a. Under Application MyFTApp, right-click Area1 > Security to open 
Security Settings for Area1 dialog box, and then select Anonymous 
Logon user group. 

b. From Permissions for Anonymous Logon from All Computers 
list, select Common > Read > Allow. 

c. From Permissions for Anonymous Logon from All Computers 
list, select Common > List Children > Allow. 

d. From Permissions for Anonymous Logon from All Computers 
list, select Tag > Write Value > Allow. 

3. Security for Area2 (using the FactoryTalk Administration Console) 
should be configured as follows: 

a. Under Application MyFTApp, right-click Area2 > Security to open 
Security Settings for Area2 dialog box, and then select Anonymous 
Logon user group. 

b. From Permissions for Anonymous Logon from All Computers 
list, select Common > Read > Deny. 

4. Security for Area3 (using the FactoryTalk Administration Console) 
should be configured as follows: 

a. Under Application MyFTApp, right-click Area3 > Security to open 
Security Settings for Area3 dialog box, and then select Anonymous 
Logon user group. 

b. From Permissions for Anonymous Logon from All Computers 
list, select Tag > Write Value > Deny. 

If a write action is attempted into Area3, the following error is logged 
in FactoryTalk Diagnostics: 

"FactoryTalk Linx Gateway write failed due to denied access for 
client ‘Client1’ group ‘Group1 (Active, 250ms)’ item ‘Area3::my_int’. 
Verify you have the correct security authorization to perform the 
write operation." 



Appendix D  Secure FactoryTalk Linx Gateway using FactoryTalk Security 
 

72 Rockwell Automation Publication FTLG-GR001C-EN-E - September 2020  
 

If you attempt to browse the FactoryTalk application, Area2 will not 
show since Read permissions have been denied. If your display has a 
tag previously referenced from Area2, its value will show as (Empty 
Data) with a Quality of Invalid Quality. The following errors are logged 
in FactoryTalk Diagnostics: 

"Cannot interpret area RNA://$Global/MyFTApp/Area2 
(result=80042062) 
Failed to add item ‘[FTI_Advanced]my_tag’ to server 
RNA://$Global/MyFTApp/Area2:RSLC’ because of insufficient access 
rights." 
Tip: Access to resources (such as applications, areas, or servers) and the 

ability to perform tasks (such as read or write) are governed by the 
permissions set in FactoryTalk Security. As a result, if you do not have the 
appropriate permission, some components on a dialog box may be 
unavailable, or entire dialog boxes or context menu selections described 
in the Help may be inaccessible. Refer to the FactoryTalk Services 
Platform Help for more information. 

 

When using the Anonymous Logon, the system administrator can manage 
tag write access in an application, area, or sub-area for FactoryTalk Linx 
Gateway servers. Tag write access is enabled (Write Tag permission is set to 
Allow) by default.  

Before you begin: 
• Find the Anonymous Logon in Users and Group > Users. 
• Do not delete or change password. 
• Check Effective permissions to verify Rights for the Anonymous Logon 

user. 

To disable write access for an application, area, or sub-area: 
1. On the FactoryTalk Administration Console application tab, click the 

application, area, or sub-area. 
2. Right-click and select Security. The Security Settings dialog box 

opens. 
3. Select Anonymous Logon from the list of users. 
4. Click and expand Tag in the list of permissions to expose the Write 

Value permission. 
5. Select the Deny check box. 
6. Click OK. 

When using the Anonymous Logon, the system administrator can manage 
tag write access for a specific computer. Use the system administrator to 
specify permissions for each FactoryTalk Linx Gateway. 

Secure tag write access for 
an application or area 

Secure tag write access for 
a computer 
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Before you begin: 
• Find the Anonymous Logon in Users and Group > Users. 
• Do not delete or change password. 
• Check Effective permissions to verify Rights for the Anonymous Logon 

user. 

To disable tag write access for a computer: 
1. On the application window, select the application, area, or sub-area. 
2. Right-click and select Security. The Security Settings dialog box 

opens. 
3. Click Add. The Select User and Computer dialog box opens. 
4. Select Anonymous Logon from the list of users. If Anonymous Logon 

is not listed, select Show users only. 
5. Select the appropriate computer from the list, If computers are not 

listed, select Show computers only, and the click OK. 
6. Click and expand Tag in the list of permissions to expose the Write 

Value permission. 
7. Select the Deny check box. 
8. Click OK. 

Use the Policy Settings tab in Feature Security Properties dialog box to 
secure features of a single FactoryTalk product. By setting permissions to a 
single feature, you can limit a user or a group of users to perform securable 
actions. 

Starting from version 6.10.00, FactoryTalk Linx Gateway enhance the user 
security by requesting the users to log on to FactoryTalk Linx Gateway server 
when starts FactoryTalk Linx Gateway Configuration and when changing the 
scope. 

The logon scope is determined by the user's activation type. If a user has a 
local license, he can only log on to local scope. If the user has a network 
license, he can logon to both network and local scope. 

To log on FactoryTalk Linx Gateway server, do one of the followings: 
• Click File > Log On. 
• Click Select next to FactoryTalk Diagnostics Scope on Server 

Configuration tab. 
Note: • If you have enabled single sign-on function in FactoryTalk Services Platform > 

Explorer > System Policies > Security Policy, there is no need to manually 
log on FactoryTalk Linx Gateway server. 

• Log off and log on back for the feature security settings to take effect. 

Feature Security Properties 
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As the product policy is configured upon the logon scope, make sure the 
FactoryTalk Linx Gateway server logon scope is the same with FactoryTalk 
Diagnostics scope. 

The following table shows the relationship between FactoryTalk Linx Gateway 
feature security policies and securable actions that the user can perform: 

Feature security policy Allow Deny 

View Gateway Server Properties Allow users to view information in Server Configuration tab 
including: 
• FactoryTalk Diagnostics Scope 
• UA Server Service Name 
• UA Server status 
• Local Discovery Service URL and status. 
• DA Server status 

Hide UA Server and DA Server information. Users can 
only select scope in Server COnfiguration tab. 

Modify Gateway Server Properties Allow users to edit in Server Configuration tab: 
• Change UA Server Service Name. 
• Inhibit UA Server communication. 
• Select if register with LDS. 
• Inhibit DA Server communication. 

Set Service Name area, UA Server Inhibit checkbox, 
Register with Discovery Service checkbox, and DA 
Server Inhibit checkbox unavailable. 

View UA Server Endpoint Properties Allow users to view UA server configuration information and 
security settings in UA Server Endpoints tab including the 
endpoints': 
• Name 
• Port 
• URL 
• Security Policy 
• Security Mode 
• Authentication Settings 
• Diagnostic Logging 

Hide the Endpoint Properties area. 

Remove UA Server Endpoint Allow users to remove the selected endpoint in UA Server 
Endpoints tab. 

Set the Remove button unavailable. 

Add/Configure UA Server Endpoint Properties Allow users to add a new endpoint and edit existing endpoints' 
configuration information and security settings in UA Server 
Endpoints tab including: 
• Name 
• Port 
• URL 
• Security Policy 
• Security Mode 
• Authentication Settings 
• Diagnostic Logging 

Set the Endpoint Properties area and the Add button 
unavailable. 

Manage Incoming Certificate Allow users to view and import, reject, trust and remove 
certificates in Certificate Management tab. 

Set the Import, Reject, Trust, and Remove button as 
unavailable. 

View Outgoing Certificate Properties Allow users to view the outgoing certificates information in 
Certificate Management > Outgoing Certificate tab. 

Set the outgoing certificate properties unavailable. 
When switching to Outgoing Certificate tab, the 
Certificate Properties area still shows the Incoming 
Certificate properties. 

Modify Outgoing UA Certificate Properties Allow users to regenerate an outgoing certificate when the old one 
is expired or there is a need to do so. 

Set the Regenerate button as unavailable. 

OPC UA Client Read Access Allow OPC UA clients to read data values through FactoryTalk Linx 
Gateway server. 

OPC UA clients cannot read data values through 
FactoryTalk Linx Gateway server. An access denied error 
occurs during communication. 
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Feature security policy Allow Deny 

OPC UA Client Write Access Allow OPC UA clients to read and write data values through 
FactoryTalk Linx Gateway server. 

OPC UA clients cannot write data values through 
FactoryTalk Linx Gateway server. An access denied error 
occurs when editing tag values. 
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Glossary 

A-F on page 77 

H-U on page 81 

 

- A -  

access path 

An access path defines the computer, driver, networks, and communication 
devices used to communicate with a destination device or processor in Object 
Linking and Embedding for Process Control (OPC) conversations. 

acknowledgment (ACK) 

An ASCII control character used to acknowledge the reception and acceptance 
of a transmission block. 

activate 

To make a Rockwell Software product active so that it can run without the 
limitations imposed by demonstration mode. Without activation, some 
Rockwell Software products will not run, some will run with diminished 
functionality, and others will run for a limited period of time and then shut 
down with or without warning. 

activation file 

A text file that contains all of the activation information that is required to 
license a software product and allow it to properly function. While the file is 
simply plain text, the contents of the file are protected by a signature. 

activation host 

The device associated with an activation by a unique ID. 

A-F 
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activation server 

An activation server is any computer that hosts concurrent activations. The 
activation server manages the activations and shares them with other 
configured computers on the network. 

alias 

A logical name for a variable in a device or memory. Similar to a tag. 

application 

A machine or process monitored and controlled by a controller or the use of 
computer-based or controller-based routines for specific purposes. 

area 

An area organizes and subdivides a distributed Network application into 
logical or physical divisions. 

- B - 

baud 

A unit of signaling speed equal to the number of discrete conditions or signal 
events per second. Where one bit is encoded on each signaling event, the 
number of baud is the same as the number of bits per second. 

Block Check Character (BCC) 

An error checking method developed to improve error detection in data 
communications. The BCC is added to the end of each block of data before the 
block is transmitted. 
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- C - 

client 

A component or subsystem that uses data or functionality provided by some 
other component or subsystem (the server). The term can also refer to the 
computer that executes this software, connecting to a server computer across 
a communication network. 

Common Industrial Protocol (CIP) 

The Common Industrial Protocol (CIP) is an industrial protocol for industrial 
automation applications supported by ODVA. Previously known as Control 
and Information Protocol, CIP defines messages and services for the 
collection of manufacturing automation applications – control, safety, 
synchronization, motion, configuration and information. It is used in 
EtherNet/IP, DeviceNet, CompoNet and ControlNet. Extensions to CIP are 
CIP Safety, CIP Motion, CIP Security, and CIP Sync. 

CIP security 

CIP security has multiple layers of security that enables a CIP-connected 
device to protect itself from malicious CIP communications. Then the device 
can reject data that has been altered, reject messages send by untrusted 
people or untrusted devices, and reject messages that request actions that are 
not allowed. CIP security defines the notion of a security profile, which is a set 
of well-defined capabilities to facilitate device interoperability and end-user 
selection of devices with the appropriate security capability.  

concurrent activation 

A type of activation that allows multiple computers across a network to use 
Rockwell Software products at the same time. Concurrent activations include 
floating activations and borrowed activations.  

configuration 

A file that contains information about the physical structure you defined for 
your system. This file includes all network paths, defined drivers and devices, 
Data Providers, and object protocols. 
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cyclic redundancy check (CRC) 

A Cyclic Redundancy Check (CRC) is an error checking technique used by 
computers. 

- D - 

DA 

See OPC DA. 

data element 

An individually addressable item of data. For example, an OPC tag, an HMI 
tag, a graphic display, an event file, a node, and a channel. 

data provider 

One of the building blocks of FactoryTalk Linx, a data provider acts as a 
multiplexer for multiple clients and optimizes what data can be read together 
for more efficient handling. 

data server 

Data servers serve tags, or data items, contained in OPC-DA (Data Access) 
servers. Clients that need access to data items use data server application 
elements to locate the computers that are hosting OPC-DA 2.0 compliant data 
servers. 

dongle 

A dongle is a security or copy protection device for commercial computer 
programs. When required by a program, a dongle must be connected to an 
input/output port, such as USB or parallel port of the computer, to allow the 
program to run. Programs that use a dongle query the port at start-up and at 
programmed intervals thereafter, and terminate if the dongle does not 
respond with the expected validation code. 
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- E - 

External Access 

A property that allows you to specify the level of access (Read Only, 
Read/Write, or None) external applications and devices have to tags. 

- F - 

floating activation 

A type of concurrent activation that requires a continuous network 
connection and allows multiple computers to use Rockwell Software products 
concurrently. An activation server manages a predetermined number of 
activations in a pool, and makes these activations available to any configured 
computer on the network. 

When a computer connects to the network and runs a Rockwell Software 
product, it automatically "checks out" an activation from the pool of available 
concurrent activations. When the product shuts down, the activation is 
automatically freed and returns to the activation server's available pool. 
Checking out activations from the pool and returning them to the server 
happens automatically, without any user intervention. 

- H - 

HMI server 

The software module that is responsible for performing core run-time 
operations such as data collection, alarm detection, historical data logging 
and retrieval, and for providing FactoryTalk View SE Clients with graphic 
displays, run-time data, and events. 

- O - 

OPC DA 

OPC (Open Platform Communications) Data Access (DA) is a non-proprietary 
technical specification that defines a set of standard interfaces based on 

H-U 
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Microsoft’s OLE/COM (Component Object Model) technology. Applying OPC 
DA standards makes interoperability possible among automation and control 
applications, field systems and devices, and business and office applications. 

The FactoryTalk Services Platform supports and extends the OPC DA 3.0 
specification, which includes the ability to browse data items. 

For more information on OPC DA, see https://opcfoundation.org 

OPC test client 

A data connections test utility that shows whether you are using Remote OPC 
Client functionality. 

OPC UA 

OPC (Open Platform Communications) Unified Architecture (UA) is a 
platform independent service-oriented architecture that integrates the 
individual OPC Classic specifications into one extensible framework. 
Applying OPC UA standards makes interoperability possible among 
automation and control applications, field systems and devices, and business 
and office applications. 

For more information on OPC UA, see https://opcfoundation.org 

- P - 

poll 

Systematically request data from a device. 

poll rate 

Often how data is requested from a device. Poll rates are typical specified in 
milliseconds. (A poll rate of 1000 ms results in data being requested every 
second). 

https://opcfoundation.org/
https://opcfoundation.org/
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- R - 

rehost (an activation) 

Rehosting an activation provides a way of moving an activation file from one 
computer or device to another. Rehosting an activation file deactivates the file 
on the computer that is hosting it, and then creates a rehost code 
that Rockwell Technical Support staff can use to generate a new activation file 
for use on another computer. 

- S - 

scope 

The level at which tags and routines may be created. They can be created at the 
controller level (accessible to all routines), or at the program level (accessible 
to only the routines within a single program). 

shortcut 

A symbolic reference to a physical device that you want to connect to on the 
network, and the data that device contains. The communication path 
associated with the shortcut tells the application where to find that data.  

- T - 

tag 

A named area of the process-connected device or controller’s memory where 
data is stored. It is the basic mechanism for allocating memory, referencing 
data from logic, and monitoring data. 

topology 

The way a network is physically structured. This includes all networks, nodes, 
devices, Data Providers, drivers/channels, and object protocols. In FactoryTalk 
Linx, this is presented in tree form (the communications tree). 
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- U - 

UA 

See OPC UA. 
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Rockwell Automation support 
Use these resources to access support information. 

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 
updates. 

rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and 
find associated firmware. 

rok.auto/pcdc 

 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

 
At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 

 

http://rok.auto/support
http://rok.auto/knowledgebase
http://rok.auto/phonesupport
http://rok.auto/literature
http://rok.auto/pcdc
http://rok.auto/docfeedback
http://rok.auto/pec
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